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SAFETY RULES & UNSAFE PRACTICES 
 

 

Remember that “accidents do not occur, they are caused”. With this in mind, strictly follow the 

general safety rules given below and safe practices indicated in brief under each section. 

 

1. Safety first, work next.  
 
2. Know your job and follow instructions.  
 
3. Avoid wearing clothing that might catch, moving or rotating parts. Long sleeves of 

shirts, long hair, neck tie and jewellery are definite hazards in the shop.  
 
4. Wear safety shoes. Do not wear canvas shoes; they give no resistance to hard 

objects dropped on the feet.  
 
5. Keep the area around machine or work clean.  
 
6. Keep away from revolving work.  
 
7. Be sure that all gaurds are in place.  
 
8. One person only should operate the machine controls.  
 
9. Use tools correctly and do not use them if they are not in proper working condition.  
 
10. Wear safety goggles when working in areas, where sparks or chips of metal are 

flying.  
 
11. Get to know who in-charge of first aid is and where boxes are placed and where the 

first aid can be found in case of emergency.  
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1. FITTING 

Introduction 

 

Machine tools are capable of producing work at a faster rate, but, there are occasions when 

components are processed at the bench. Sometimes, it becomes necessary to replace or repair 

component which must be fit accurately with another component on reassembly. This involves a 

certain amount of hand fitting. The assembly of machine tools, jigs, gauges, etc, involves certain 

amount of bench work. The accuracy of work done depends upon the experience and skill of the 

fitter. 

 
The term ‘bench work’ refers to the production of components by hand on the bench, where as 
fitting deals which the assembly of mating parts, through removal of metal, to obtain the required 

fit. 

 

Both the bench work and fitting requires the use of number of simple hand tools and 

considerable manual efforts. The operations in the above works consist of filing, chipping, 

scraping, sawing drilling, and tapping. 
 
Holding Tools: 

 

Bench Vice 

 

The bench vice is a work holding device. It is the most commonly used vice in a fitting shop. 
The bench vice is shown in figure below. 

 

It is fixed to the bench with bolts and nuts. The vice body consists of two main parts, fixed jaw 

and movable jaw. When the vice handle is turned in a clockwise direction, the sliding jaw forces 

the work against the fixed jaw. Jaw plates are made of hardened steel. Serrations on the jaws 

ensure a good grip. Jaw caps made of soft material are used to protect finished surfaces, gripped 

in the vice. The size of the vice is specified by the length of the jaws. 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Bench Vice 
The vice body is made of cast iron which is strong in compression, weak in tension and so 
fractures under shocks and therefore should never be hammered. 
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V‐block is rectangular or square block with a V‐groove on one or both sides opposite to each 

other. The angle of the ‘V’ is usually 900
. V‐block with a clamp is used to hold cylindrical work 

securely, during layout of measurement, for measuring operations or for drilling for this the bar 

is faced longitudinally in the V‐Groove and the screw of V‐clamp is tightened. This grip the rod 

is firm with its axis parallel to the axis of the v‐groove. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: V‐ Block Fig: C ‐ Clamp 
 

C‐ Clamp 

 

This is used to hold work against an angle plate or v‐block or any other surface, when gripping is 

require Its fixed jaw is shaped like English alphabet ‘C’ and the movable jaw is round in shape 
and directly fitted to the threaded screw at the end .The working principle of this clamp is the 

same as that of the bench vice. 
 
Marking and Measuring Tools: 
 

Surface Plate 

 

The surface plate is machined to fine limits and is used for testing the flatness of the work piece. 

It is also used for marking out small box and is more precious than the marking table. The degree 

of the finished depends upon whether it is designed for bench work in a fitting shop or for using 

in an inspection room; the surface plate is made of Cast Iron, hardened Steel or Granite stone. It 

is specified by length, width, height and grade. Handles are provided on two opposite sides, to 

carry it while shifting from one place to another (refer figure in next page). 
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It is measuring and marking tool for 90
0
 angle .In practice, it is used for checking the squareness 

of many types of small works when extreme accuracy is not required .The blade of the Try 

square is made of hardened steel and the stock of cast Iron or steel. The size of the Try square is 

specified by the length of the blade. 
 
Scriber 

A Scriber is a slender steel tool, used to scribe or mark lines on metal work pieces. It is made of 

hardened and tempered High Carbon Steel. The Tip of the scriber is generally ground at 12
o
to 

15
o
. 

 
It is generally available in lengths, ranging from 125mm to 250mm .It has two pointed ends the 
bent end is used for marking lines where the straight end cannot real. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Try Square Fig: Scriber 
 
Odd Leg Caliper 

This is also called ‘Jenny Caliper’ or Hermaphrodite. This is used for marking parallel 
liners from a finished edge and also for locating the center of round bars; it has one leg pointed 

like a divider and the other leg bent like a caliper. It is specified by the length of the leg up to the 

hinge point. 

Divider 
It is basically similar to the calipers except that its legs are kept straight and pointed at the 

measuring edge. This is used for marking circles, arcs laying out perpendicular lines, by setting 

lines. It is made of case hardened mild steel or hardened and tempered low carbon steel. Its size 

is specified by the length of the leg. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Odd Leg Caliper and Divider 
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Trammel is used for drawing large circles or arcs. 

Punches 
These are used for making indentations on the scribed lines, to make them visible clearly. These 

are made of high carbon steel. A punch is specified by its length and diameter (say as 150’ 
12.5mm). It consists of a cylindrical knurled body, which is plain for some length at the top of it. 

At the other end, it is ground to a point. The tapered point of the punch is hardened over a length 

of 20 to 30mm. 

 

Dot Punch is used to lightly indent along the layout lines, to locate center of holes and to 

provide a small center mark for divider point, etc. for this purpose, the punch is ground to a 

conical point having 60° included angle. 

 
Center Punch is similar to the dot punch, except that it is ground to a conical point having 90° 
included angle. It is used to mark the location of the holes to be drilled. 
 
 
 
 
 
 
 
 
 
 

Fig: Punches 

Calipers: 

They are indirect measuring tools used to measure or transfer linear dimensions. These are used 

with the help of a steel Rule to check inside and outside measurements. These are made of Case 

hardened mild steel or hardened and tempered low carbon steel. While using, but the legs of the 

caliper are set against the surface of the work, whether inside or outside and the distance between 

the legs is measured with the help of a scale and the same can be transferred to another desired 

place. These are specified by the length of the leg. In the case of outside caliper, the legs are bent 

inwards and in the case of inside caliper, the legs bent outward. 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                              Fig: Calipers 

Cutting Tools: 
 
Hack Saw 
The Hack Saw is used for cutting metal by hand. It consists of a frame, which holds a thin blade, 
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firmly in position. Hacksaw blade is specified by the number of teeth for centimeter. Hacksaw 

blades have a number of teeth ranging from 5 to 15 per centimeter (cm). Blades having lesser 

number of teeth per cm are used for cutting soft materials like aluminum, brass and bronze. 

Blades having larger number of teeth per centimeter are used for cutting hard materials like steel 

and cast Iron. 
 
 
 
 
 
 
 
 
 

 

Fig: Hacksaw Frame with Blade 
 
 
Hacksaw blades are classified as (i) All hard and (ii) flexible type. The all hard blades are made 

of H.S.S, hardened and tempered throughout to retain their cutting edges longer. These are used 

to cut hard metals. These blades are hard and brittle and can break easily by twisting and forcing 

them into the work while sawing. Flexible blades are made of H.S.S or low alloy steel but only 

the teeth are hardened and the rest of the blade is soft and flexible. These are suitable for use by 

un‐skilled or semi‐skilled persons. 

 
The teeth of the hacksaw blade are staggered, as shown in figure and known as a ‘set of teeth’. 
These make slots wider than the blade thickness, preventing the blade from jamming. 
 
 
Chisels 

 

Chisels are used for removing surplus metal or for cutting thin sheets. These tools are made from 

0.9% to 1.0% carbon steel of octagonal or hexagonal section. Chisels are annealed, hardened and 

tempered to produce a tough shank and hard cutting edge. Annealing relieves the internal 

stresses in a metal. The cutting angle of the chisel for general purpose is about 60°. 
 
 
 
 
 
 
 
 

Fig: Flat Chisel 
 
 

Twist Drill 

 

Twist drills are used for making holes. These are made of High speed steel. Both straight and 

taper shank twist drills are used. The parallel shank twist drill can be held in an ordinary self – 



M R C E T                          ENGINEERING WORKSHOP MANUAL    B.TECH 1
ST

 YEAR 

 

DE 
D E P A R T M E N T  O F  M E C H A N I C A L  E N G I N E E R I N G  

 

Page 9 

centering drill check. The tapper shank twist drill fits into a corresponding tapered bore provided 

in the drilling machine spindle (see figure in next page). 
 
Taps and Tap Wrenches 

 

A tap is a hardened and steel tool, used for cutting internal thread in a drill hole. Hand Taps are 

usually supplied in sets of three in each diameter and thread size. Each set consists of a tapper 

tap, intermediate tap and plug or bottoming tap. Taps are made of high carbon steel or high speed 

steel (see figure in next page). 

Bench Drilling Machine 
Holes are drilled for fastening parts with rivets, bolts or for producing internal thread. Bench 

drilling machine is the most versatile machine used in a fitting shop for the purpose. Twist drills, 

made of tool steel or high speed steel are used with the drilling machine for drilling holes. 
 
Following are the stages in drilling work 
 
1. Select the correct size drills, put it into the check and lock it firmly  
 
2. Adjust the speed of the machine to suit the work by changing the belt on the pulleys. Use 

high speed for small drills and soft materials and low speed for large diameter drills and hard 

materials.   
3. Layout of the location of the pole and mark it with a center punch.  
 
4. Hold the work firmly in the vice on the machine table and clamp it directly on to the machine 

table.  
 
5. Put on the power, locate the punch mark and apply slight pressure with the Feed Handle.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Bench Drill 
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Finishing Tools: 
 
Reamers 
Reaming is an operation of sizing and finishing a drilled hole, with the help of a cutting tool 

called reamer having a number of cutting edges. For this, a hole is first drilled, the size of which 

is slightly smaller than the finished size and then a hand reamer or machine reamer is used for 

finishing the hole to the correct size. 
 
Hand Reamer is made of High Carbon Steel and has left‐hand spiral flutes so that, it is prevented 

from screwing into the whole during operation. The Shank end of the reamer is made straight so 

that it can be held in a tap wrench. It is operated by hand, with a tap wrench fitted on the square 

end of the reamer and with the work piece held in the vice. The body of the reamer is given a 

slight tapper at its working end, for its easy entry into the whole during operation, it is rotated 

only in clock wise direction and also while removing it from the whole. 
 
 
 
 
 
 
 
 
 
 
 

Fig: Reamers 
 
Files 

 

Filing is one of the methods of removing small amounts of material from the surface of a metal 

part. A file is hardened steel too, having small parallel rows of cutting edges or teeth on its 

surfaces. 

 

On the faces, the teeth are usually diagonal to the edge. One end of the file is shaped to fit into a 

wooden handle. The figure shows various parts of a hand file. The hand file is parallel in width 

and tapering slightly in thickness, towards the tip. It is provided with double cut teeth. On the 

faces, single cut on one edge and no teeth on the other edge, which is known as a safe edge. 
 
 
 
 
 
 
 

 

Fig: Parts of a Hand File 

 
Files are classified according to their shape, cutting teeth and pitch or grade of the teeth. The 
figure shows the various types of files based on their shape. 
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Fig: Single and Double Cut Files 

 
 
Miscellaneous Tools: 
 

Ball‐ Peen Hammer 

Ball‐ Peen Hammers are named, depending upon their shape and material and specified by their 

weight. A ball peen hammer has a flat face which is used for general work and a ball end, 

particularly used for riveting. 
 
 

 

 

 

Cross‐Peen Hammer 

 

It is similar to ball peen hammer, except the shape of the peen. This is used for chipping, 
riveting, bending and stretching metals and hammering inside the curves and shoulders. 
 
 
 
 
 
 
 
 

 

Fig: Cross Peen Hammer Fig: Straight Peen Hammer 
 

Straight‐Peen Hammer 

 

This is similar to cross peen hammer, but its peen is in‐line with the hammer handle. It is used 

for swaging, riveting in restricted places and stretching metals. 
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Viva Questions 

 
Question: Define the terms: Fitting and Bench work. 
 
Question: Name the material with which a vice body is normally made of. What is the 

characteristic of this material? 
 
Question: What for a C-clamp is used? 
Question: Classify hacksaw blades. 
 
Question: Differentiate between ‘Single cut’ and ‘Double cut’ files. 
Question: Differentiate between ‘Cross filing’ and ‘Draw filing’. Question: 
Name the different types of hammers used in fitting work. 
 
Question: Differentiate between cross-peen hammer and straight-peen hammer. 
Question: What is meant by pinning of files?  
Question: With what the size of a spanner is denoted? 
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2.CARPENTRY 
 
Introduction 

Carpentry may be defined as the process of making wooden components. It starts from a 

marketable form of wood and ends with finished products. It deals with the building work, 

furniture, cabinet making. Etc. joinery, i.e., preparation of joints is one of the important 

operations in all woodworks. It deals with the specific work of carpenter like making different 

types of joints to form a finished product. 
 
Timber: 

 
Timber is the name given to the wood obtained from well grown trees. The trees are cut, sawn 
into various sizes to suit building purposes. 

 

The word, ‘grain’, as applied to wood, refers to the appearance or pattern of the wood on the cut 
surfaces. The grain of the wood is a fibrous structure and to make it strong, the timber must be so 

cut, that the grains run parallel to the length. 
 
Timber Sizes 

 
Timber sold in the market is in various sizes and shapes. The following are the common shapes 
and sizes. 
a. Log ‐ The trunk of the tree which is free from branches.   
b. Balk ‐ The log, sawn to have roughly square cross section.  
 
c. Post ‐ A timber piece, round or square in cross section, having its diameter or side from 

175 to 300mm.  
 
d. Plank ‐ A sawn timber piece, with more than 275 mm in width, 50 to 150 mm in 

thickness and 2.5 to 6.5 meters in length.   
e. Board ‐ A sawn timber piece, below 175 mm in width and 30 to 50 mm in thickness.  
 
f. Reapers‐ Sawn timber pieces of assorted and non‐standard sizes, which do not confirm to the 

above shapes and sizes.  

 

Classification of Timber 

 

Wood suitable for construction and other engineering purposes is called timber. Woods in 
general are divided into two broad categories: Soft woods and Hard woods. 

 

Soft woods are obtained from conifers, kair, deodar, chir, walnut and seemal. Woods obtained 

from teak, sal, oak, shisham, beach, ash mango, neem and babul are known as hard wood, but it 

is highly durable. 

 
Another classification of woods is based on the name of the trees like teak, babul, shisham, 
neem, kair, chir, etc. 
 
 



M R C E T                          ENGINEERING WORKSHOP MANUAL    B.TECH 1
ST

 YEAR 

 

DE 
D E P A R T M E N T  O F  M E C H A N I C A L  E N G I N E E R I N G  

 

Page 18 

 

Seasoning of Wood 
 
 
A newly felled tree contains considerable moisture content. If this is not removed, the timber is 

likely to wrap, shrink, crack or decay. Seasoning is the art of extracting the moisture content 

under controlled conditions, at a uniform rate, from all the parts of the timber. Only seasoned 

wood should be used for all carpentry works. Seasoning makes the wood resilient and lighter. 

Further, it ensures that the wood will not distort after it is made into an object. 
 
Characteristics of Good Timber 
 
The good timber must possess the following characteristics 

 

a. It should have minimum moisture content, i.e., the timber should be well seasoned.   
b. The grains of wood should be straight and long.   
c. It must retain its straightness after seasoning.   
d. It should produce near metallic sound on hammering.   
e. It should be free from knots or cracks.   
f. It should be of uniform color, throughout the part of the wood.   
g. It should respond well to the finishing and polishing operations.   
h. During driving the nails and screw, it should not split easily.  

Marking and Measuring Tools: 
Accurate marking and measurement is very essential in carpentry work, to produce parts to exact 

size. To transfer dimensions onto the work; the following are the marking and measuring tools 

that are required in a carpentry shop. 
 
Steel Rule and Steel Tape 

 

Steel rule is a simple measuring instrument consisting of a long, thin metal strip with a marked 

scale of unit divisions. It is an important tool for linear measurement. Steel tape is used for large 

measurements, such as marking on boards and checking the overall dimensions of the work. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Steel Rule and Steel Tape 
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Marking Gauge 

 

It is a tool used to mark lines parallel to the edge of a wooden piece. It consists of a square 

wooden stem with a sliding wooden stock (head) on it. On the stem is fitted a marking pin, made 

of steel. The stock is set at any desired distance from the marking point and fixed in position by a 

screw. It must be ensured that the marking pin projects through the stem, about 3 mm and the 

end are sharp enough to make a very fine line. A mortise gauge consists of two pins. In this, it is 

possible to adjust the distance between the pins, to draw two parallel lines on the stock. 
 
 
 
 
 
 
 
 
 
 

 

Marking gauge Mortise gauge 
 

Fig: Marking Gauges 
 

Try ‐ Square 

 

It is used for marking and testing the squareness and straightness of planed surfaces. It consists 

of a steel blade, fitted in a cast iron stock. It is also used for checking the planed surfaces for 

flatness. Its size varies from 150 to 300 mm, according to the length of the blade. It is less 

accurate when compared to the try‐square used in the fitting shop. 
 
 
 
 
 
 
 
 
 
 
 

Fig: Try Square 

Compass and Divider 
Compass and divider, are used for marking arcs and circles on the planed surfaces of the wood 
(refer fig in next page). 
 
 

 

Scriber or Marking Knife 

 
It is used for marking on timber. It is made of steel having one end pointed and the other end 
formed into a sharp cutting edge (refer Fig. in next page). 
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Bevel Square 

It is used for laying‐out and checking angles. The blade of the bevel is adjustable and may be 

held in place by a thumb screw. After it is set to the desired angle, it can be used in much the 

same way as a try‐square. A good way to set it to the required angle is to mark the angle on a 

surface and then adjust the blade to fit the angle 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fig: Compass and Divider Fig: Scriber and Bevel Square 
 
 
Holding Tools: 
 
Carpenter's Vice 

 

It is used as a work holding device in a carpenter shop. Its one jaw is fixed to the side of the table 

while the other is movable by means of a screw and a handle. The Carpenter's vice jaws are lined 

with hard wooden' faces 
 
 
 
 
 
 
 
 
 
 
Fig: Carpenters Vice Fig: C‐Clamp 

C‐Clamp 

It is used for holding small works (see figure above) 
 
Bar Cramp 
It is made of steel bar of T‐section, with malleable iron fittings and a steel screw. It is used for 

holding wide works such as frames or tops. 
 
Planing Tools: 

 

Planing is the operation used to produce flat surfaces on wood. A plane is a hand tool used for 

this purpose. The cutting blade used in a plane is very similar to a chisel. The blade of a plane is 

fitted in a wooden or metallic block, at an angle. 
 
Types of Planes: 
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Jack Plane 

 

It is the most commonly used general purpose plane. It is about 35 cm long. The cutting iron 

(blade) should have a cutting edge of slight curvature. It is used for quick removal of material on 

rough work and is also used in oblique planning. 
 
Smoothing Plane 

 

It is used for finishing work and hence, the blade should have a straight cutting edge. It is about 

20 to 25 cm long. Being short, it can follow even the slight depressions in the stock, better than 

the jack plane. It is used after using the jack plane. 
 

Rebate Plane 

 
It is used for making a rebate. A rebate is a recess along the edge of a piece of wood, which is 
generally used for positioning glass in frames and doors. 
 

Plough Plane 

 
It is used to cut grooves, which are used to fix panels in a door. The following figure shows the 
various types of planes mentioned above. 
 
 
 

 

 

 

 

 

Cutting Tools: 

Saws 
A saw is used to cut wood into pieces. There are different types of saws, designed to suit 
different purposes. A saw is specified by the length of its toothed edge. 

Types of Saws: 

Cross‐Cut Saw or Hand Saw 

It is used to cut across the grains of the stock. The teeth are so set that the saw kerf will be wider 

than the blade thickness. This allows the blade to move freely in the cut, without sticking 

Rip Saw 

 

It is used for cutting the stock along the grains. The cutting edge of this saw makes a steeper 

angle, i.e., about 60° whereas that of crosscut saw makes an angle of 45° with the surface of the 
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stock. 

Tenon Saw 
It is used for cutting the stock either along or across the grains. It is used for cutting tenons and 

in fine cabinet work. However, it is used for small and thin cuts. The blade of this saw is very 

thin and so it is stiffened with a thick back steel strip. Hence, this is sometimes called as 

back‐saw. In this, the teeth are shaped like those of cross‐cut saw. 

Compass Saw 
It has a narrow, longer and stronger tapering blade, which is used for heavy works . It is mostly 

used in radius cutting. The blade of this saw is fitted with an open type wooden handle. 
 
 
 
 
 
 
 
 
 

Fig: Types of Saws 

Chisels: 

 

Chisels are used for cutting and shaping wood accurately. Wood chisels are made in various 

blade widths, ranging from 3 to 50 mm. They are also made in different blade lengths. Most of 

the wood chisels are made into tang type, having a steel shank which fits inside the handle. 

These are made of forged steel or tool steel blades. 
 
 
 

 

 

Fig: Types of Chisels 
 
Types of Chisels: 
 

Firmer Chisel 
The word 'firmer' means 'stronger' and hence firmer chisel is stronger than other chisels. 

It is a general purpose chisel and is used either by hand pressure or by a mallet. The blade of a 

firmer chisel is flat, as shown in figure. 
 
Dovetail Chisel 
It has a blade with a beveled back, as shown in Figure, due to which it can enter sharp comers 
for finishing, as in dovetail joints. 
 
Mortise Chisel 

It is used for cutting mortises and chipping inside holes, etc. The cross‐section of the 

mortise chisel is proportioned to withstand heavy blows during mortising. Further, the 

cross‐section is made stronger near the shank.. 
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Viva Questions 

 

Question: Name the commonly available shapes of timber in the market. 

Question: What is the sequence of operations in carpentry? 
 
Question: What is the difference between marking gauge and marking knife? 

Question: What is the difference C-clamp and bar cramp? 
 
Question: What for a plane is used in a carpentry shop? 

Question: Classify the planning tools. 
 
Question: Classify the chisels and their applications. 

Question: Name the tools used for pulling nails. 
 
Question: Name the various joinery materials used in carpentry. 

Question: Name the various types of joints. 
 
Question: Name some holding, marking, measuring, cutting, planning and finishing tools. 
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INTRODUCTION  

3.TIN SMITHY: 

Tin smithy deals with the production of components in a wide variety of shapes and sizes 

from a sheet of metal with the aid hand or machines. For example many Engineering and house 

hold articles such as hoppers, guards covers, boxes and cans, funnels and ducts etc. are made 

from a flat sheet of metal. 

 

Sheet Metals Used in Metal Work: 

 

A wide variety of metals, in the form of sheet are used in sheet metal workshop. The most 
commonly used are explained below. 
 
Galvanized Iron (G.I.) Sheet 

 

It is a sheet of soft steel coated with zinc. I sheet is one of the least expensive metals used in 

sheet metal shop. It is used for making pans, buckets, gutters, tanks, boxes etc. Generally GI 

products are very suitable for corrosive environment because zinc coating protects the iron form 

corrosion. 
 
Copper 

 

It has reddish color and is used for water pipes, roofing, gutters and other parts of the building. 

Copper products are used where thermal resistance is the criterion along with corrosion 

resistance. But copper is somewhat expensive. 
 
Tin Plate 

 
Tin plate is the iron or steel coated with pure tin. It has bright silvery appearance and is used for 
containers, dairy equipments, furnace fittings, cans, trays and pans. 
 
Stainless Steel 

 

The 18-8 type steel is used in sheet metal work from the available different type of stainless 

steel. The products like food containers, dairy equipments and kitchen wares are prepare from 

18-8 steel. 
 
Black Iron 

 
It is an uncoated sheet of metal with bluish appearance. The black iron sheet is used for the 
products, which are having no restrictions on painting after its preparation. 
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Aluminium 

 
It is an uncoated sheet of metal with bluish appearance. The black iron sheet is used for the 
products, which are having no restrictions on painting after its preparation. 
 

Tools and Equipments: 

 
Most of the tools that are used in fitting are also used in sheet metal work. The additional tools 
specially used in sheet metal work are described below. 

 

Steel Rule 

 
Steel rule is a simple measuring instrument consisting of a long, thin metal strip with a marked 
scale of unit divisions. It is an important tool for linear measurement. 
 
 
 
 
 
 
 
 

 

Fig: Steel Rule 
 
Try Square 

 

It is measuring and marking tool for 900 angle .In practice, it is used for checking the squareness 

of many types of small works when extreme accuracy is not required .The blade of the Try 

square is made of hardened steel and the stock of cast Iron or steel. The size of the Try square is 

specified by the length of the blade. 
 
 
 
 
 
 
 
 
 
 
 

Fig: Try Square 
 
Compass and Divider 

 
Compass and divider, are used for marking arcs and circles on the planed surfaces of the GI 
sheet. 

Snips: 
Snips are hand shears varying in length from 200mm to 600mm. The 250 mm length is 

the commonly used one. 
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Types of Snips: 
 
Straight snip 

 
It has a straight blade and is used for cutting along straight lines and for trimming the edges. The 
straight snip and its usage is shown in figure below: 
 
 
 
 
 
 
 
 
 

Fig: Straight Snip 
 
Bent or Curved Snip 

 

It is having curved blade and is used for cutting circles and irregular shapes. It is also used for 

trimming the cylindrical edges. The curved snip and its usage is shown in figure below: 
 
 
 
 
 
 
 

 

Fig: Bent or Curved Snip 
 
 
 
Double Snip 

 
Double shears are used for cutting thin cylinders, stove pipes and for cutting holes and light 
gauge metals. The double cut snip is shown in figure below: 
 
 
 
 
 
 
 

 

Fig: Double Snip 
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Bench Shear 

 

In this type of hand cutting machine, the sheet is cut by shearing action. The force is applied 

through compound lever. The machine is able to cut the sheet metal upto 2 mm thick. 

 
The bench shear also consists of chopping hole in the chopping blade which can shear a mild 
steel rod upto 10 mm diameter. The below figure represents the schematic diagram of bench 
shear. 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Bench Shear 

Stakes: 

Stakes are supporting tools used in sheet metal work. These are used to form, seam, bend or rivet 

the sheet metal objects. Stakes are made of wrought iron, faced with steel. Its working face well 

machined and polished to prevent harmful effect to sheet while doing the hammering process. 

Types of Stakes: 

 

Funnel Stake 
It is used for forming conical shapes and for making wire rings. The below figure shows the line 
diagram of funnel stake: 
 
Half Moon Stake 

 
It is used for folding edges of cylindrical shaped articles. The half moon stake is shown in figure 
below: 
 
Beak Horn Stake 

 
It is used for shaping round, square surfaces, bending edges, and making corners. The beak horn 
stake is shown in figure below: 
 
 
 
 
 
 

 
It is used for forming or seaming funnels. The below figure represents the blow horn stake: 
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Conductor Stake 

 
It is used for forming pipes and cylindrical pieces. The conductor stake is shown in figure below: 
 
 
Hatchet Stake 

 
It has a horizontal sharp straight edge and is used for making straight, sharp bends and folding 
edges. The schematic representation of hatchet stake is shown in figure below: 
 
 
 
 
 
 
 
 
 
 
 

Fig: Hatchet Stake  

                              Fig: Setting Hammer 

Hammers and Mallets: 

 
Hammers and mallets are used to apply moderate forces gently in the processes accompanied in 
tinsmithy such as forming and bending. 
 
Types of Hammers and Mallets: 

 

Setting Hammer 

 
It has a square, flat face and its peen is tapered on one side. It is used for setting down the edges 
for making a double seam. The below figure represents the setting hammer: 
 
Riveting Hammer 

 
It has a square slightly curved face and its peen is tapered. It is used for riveting. The riveting 
hammer is represented in figure below: 
 
 
 
 
 
 
 

 

Fig: Riveting Hammer 
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Raising Hammer 

 
It is used for making depressions on a flat sheet, and it is particularly adapted for making trays, 
bowls, and similar objects. The sketch of raising hammer is shown in figure below: 
 
 
 
 
 
 
 
 
 
 

 

Fig: Raising Hammer 
 
Mallet: 

 
It is generally made of wood or plastic. It is used whenever slight blows are required. Wooden 
hammer (mallet) is most commonly used because it does not damage the work surface. The 
simple mallet used in tinsmithy is shown in figure below: 
 
 
 
 
 
 
 
 

 

Fig: Mallet 
 
Miscellaneous Tools: 
 
Hand Groover 
 
 
It is used for grooving a seam by a hand. It has a recessed end to fit over the block of seam. The 
shape of hand groover and usage is shown in figure below. 
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INTRODUCTION  

4.HOUSE WIRING 

Power is supplied to domestic installations through a phase and a neutral, forming a 

single phase A.C.230V, two-wire system. For industrial establishments, power is supplied 

through three-phase four wire system, to give 440 V. Figure 3.1 shows the power tapping for 

domestic and industrial purposes. The neutral is earthed at the distribution sub-station of the 

supply. 

 

When supplied to domestic utilities, power is fed to a kilowatt meter and then to a distribution 

panel. The panel distributes power along several circuits. It also protects these circuits from 

overload by safety devices like fuses or circuit breakers. The panel also serves as a main switch. 

 

As a safety practice, all single-phase devices such as switches, fuses, etc., are connected to the 

live conductor. All electrical conductors and cables are color coded and must be correctly 

connected-up. Electrical wiring is defined as a system of electric conductors, components and 

apparatus for conveying electric power from the source to the point of use. The wiring system 

must be designed to provide a constant voltage to the load. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig: 3 Phase – 4 Wire Supply 

 

Elements of House Wiring: 

 

Fuses and Circuit Breakers 

 

These are the devices designed to provide protection to a circuit against excess current. In old 

type of distribution panels, open link fuses, plug or cartridge fuses were used. In newer panels, 

circuit breakers are used. If something goes wrong with an appliance or supply, the 
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line becomes over loaded or short-circuited. Then, either the fuse blows-out or circuit breaker 

trips open, isolating that circuit or appliance. In such cases, the appliance must be checked for 

defects or it must be ensured that there are not too many appliances in that particular circuit. 

 

Figure below shows several forms of fuses that are in use. Open link fuses are not safe in 

operation, even though they are cheaper and reliable. It consists of a thin strip of metal or wire. 

Here, when the fuse blows-off due to heavy current in the circuit, the metal is spilled around. A 

modified version of it consists of a porcelain fuse link, backing the wire safely. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Forms of Fuses 

 

Through the plug fuse confines the molten metal thrown out while blowing, it is not very 

accurate in operation. The length of the element also is very short. The cartridge fuse of non-

renewable type, enclose the fuse element in a fiber tube with a non-inflammable material. During 

the blowing-off, the arc produced is chilled by the non-inflammable material. In case of a 

renewable type, a cheap renewable fuse material is used in the cartridge. 

 

The trouble with fuses is that they must be replaced once they burn away, whereas the circuit 

breaker can be reset after the original condition is established. An electromagnetic circuit breaker 

is shown in below figure. A set of switch contacts inside the circuit breaker is normally kept 

closed by an armature. When too much current flows through the coil, the armature is attracted, 

breaking the circuit. The circuit breaker may be reset by a toggle lever. 
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Common House Wiring Connections: 

 

One Lamp Controlled by a One Way Switch 

 

Figure (a) below shows the wiring diagram for a lamp controlled by a one way switch. This is 

the normal connection one comes across in house wiring. However, more than one lamp may be 

connected either in series or parallel and controlled by a one way switch as shown in figures b & 

c respectively. 

 

Lamp with Independent Control from Two Places 

 

It is sometimes desirable to control from two different places .one may come across this situation 

with stair case, bed room, long corridors or hall containing two entrances, etc.this is achieved by 

two way switches as shown in fig.d. 

 

Two Lamps Connected in Series or Parallel by a One Way Switch 

 

Two lamps may be connected by a one way switch in parallel for bright glow or in series for dull 

glow .this is recommended when the intensity in the room as to be controlled (fig.e). 

 

Tube Light Connection 

 

Figure (f) shows a typical tube light connection. Tube lights are the commonly used light 

sources for illumination in the houses, industries, commercial organizations, etc. A tube light is 

a low power mercury discharge lamp with internal surface coated with suitable fluorescent 

material. This lamp consist of a glass tube, provided at both ends with caps having two pins 

and oxide coated tungsten filament. The tube contains argon or krypton gas to facilitate 

starting with small quantity of mercury at low pressure.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Types of Connections 
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Fluorescent material when subjected to electromagnetic radiations of a particular wave 

length produced by the discharge till mercury vapor gets excited and in turn gives out radiations 

at some other wave length which falls under visible spectrum. These secondary radiations from 

fluorescent powder increase the efficiency of the lamp. Tube lights are generally made of 20 

Watt or 40 Watt rating. In order to make a tube light self starting a starter and a choke are 

connected in the circuit as shown in Fig. f. 

 

When switch s1 is closed, full supply voltage induces across the starter electrodes P and Q which 

are enclosed in a glass bulb, filled with organ gas. This voltage causes discharge in the organ gas, 

resulting in the heating of the electrodes. Due to this heating, the electrode P which is made of 

bimetallic strip, bends closes the contact of the starter. At this stage the choke, the filaments M1 

and M2 of the tube T and the starter become connected in series across the supply; causing 

current flow through the filaments M1 and M2 and heating them. Mean while, the argon gas 

discharge in the starter tube disappears causing sudden break between electrodes P and Q. This 

causes a high value of induced e.m.f in the choke. The induced e.m.f in the choke is applied 

across the tube light electrodes M1 and M2 and is responsible for initiating a gaseous discharge. 

Thus, the tube light starts giving light output. Once the discharge through the tube is established, 

a much lower voltage than the supply voltage is required to maintain it. A reduction in voltage 

available at the tube during running condition is achieved by having a voltage drop across the 

choke.  

Thecapacitor connected across the starter terminals P and Q is used to suppress the 

electromagnetic waves generated at the gap due to sparking. 

 
Note: the wattage of the tube, choke and starter should be the same. 

 

Earthing 

 

The definition of the term, “earthing or grounding” as it is otherwise called, refers to the 
connection of the electrically equipment to the mass of the earth by a wire of negligible 

resistance for the safety of the human body from shocks. The metallic covers of the machines, 

the frames of the machines, sheathing of wiring, etc. are generally dead. Failure of insulation or 

workmanship may make these alive. When this happens, a person touching the parts receives an 

electric shock. To avoid this, the relevant parts are earthed. A good earthing system should have 

a very low resistance and should be in a position to allow the leakage current through it. The 

following are the methods of earthing: 

 
(i) Earthing through a water main,  

 
(ii) Plate earthing, and  

 

(iii) Pipe earthing  
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The following are the some of the items that need earthing: Metallic coverings containing 

electric supply wire, switches, distribution fuse boards, ceiling fans, generator frames, stationary 

and portable motors, metallic parts of transformer, refrigerators, energy meters, cooking oven, 

electric heaters, etc. 

 

Safe Practices 

 
1. When closing the electric switch, always grasp the switch by the insulated handle  

 

2. Do not run too many electrical items from one point  

 

3. Use fuses in the circuit breakers of proper capacity, so as to interrupt the current before it 
becomes dangerous  

 

4. Disconnect the units to be repaired, free from power supply and make sure that they might not 
be energized while the repair work continues  

 

5. Do not pour water to put off fires in electric wires and electric equipment. You will be 

subjected to electric shock or you will be electrocuted use sand to put off fires in electric items.  

 

6. Whenever there is power failure put-off the power supply to all equipments in order to prevent 
spontaneous recovery  
 
7. Never remove a plug from an outlet by pulling the cord. Always pull by the plug.  

 

8. Never work on electric wires when the power is on  

 
9. Never work with bare feet  

 

10. While testing, always keep one hand in your pocket. If the hands are in contact with a circuit, 
a current will flow across your body and is more dangerous.  

 

11. Electricity has no respect for ignorance. Do not apply voltage or turn-on any device until it 
has been properly checked.  

 
12. Check the earth connection before switching-on portable equipment  

 

13. Before replacing the blown fuse, always switch-off the main switch  
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Viva Questions 

 
Question: Define electric wiring. 
 
Question: Name the safety devices used to protect the electric circuits from overload. 
Question: Differentiate between a fuse and a circuit breaker. 
 
Question: What for a lamp holder is used in an electric circuit? 

Question: Name the types of lamp holders available in the market. 

Question: What for a ceiling rose is used? 
 
Question: What is meant by an electric circuit? Question: 

Name the three types of electrical circuits. Question: Name the 

motor driven household appliances. 
 
Question: What are the precautions to be taken, while connecting the wires with electrical 

accessories? 
 
Question: What is the difference emergency lamp and indicator lamp? 
Question: Define the term earthing or grounding.  
Question: Name the different methods of earthing. 
 
Question: How much is the power supply required for house wiring? 

Question: What is the purpose of choke in the fluorescent tube circuit? 

Question: What is the purpose of starter in the fluorescent tube circuit? 
 
Question: What is the reason of using parallel connections usually in the house wiring? 
Question: What is the reason of getting less brilliancy of each bulb in series connections? 
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7.FOUNDARY 
Introduction 

 

Foundry practice deals with the process of making castings in molds, formed in either sand or 

some other material. The process involves the operations of pattern making, sand preparation, 

molding, melting of metals, pouring in molds, cooling, shake-out, heat treatment, finishing, and 

inspection. 

 

Pattern 

 

Pattern is the principal tool during the casting process. It may be defined as a model of anything, 

so constructed that it may be used for forming an impression called would in damp sand or other 

suitable material. 

 

When this mold is filled with molten metal and the metal is allowed to solidify it forms a 

reproduction of the pattern and is known as casting. The process of making pattern is known as 

pattern making. 

 

Mold 

 

Mold is cavity formed by the pattern. It is similar in shape and size to that of the actual casting 

plus some allowances for shrinkage, machining etc. Molds are classified as temporary and 

permanent. Temporary molds are made of refractory sand and other binding materials and may 

be produced either through hand molding or machine molding. 

 

Molding Sand 

 

Sand is the principal material used in foundry. The principal ingredients of molding sands are: 

Silica sand, clay, moisture, and miscellaneous materials. Silica sand withstands very high 

temperatures and doesn’t react with the molten metal. 
 

Clay imparts the necessary bonding strength to the molding sand. 

 
Moisture in requisite amount furnishes the bonding action of clay. 

 

Miscellaneous materials that are formed in addition to silica and clay penetrates the mixture and 
forms a microfilm which coats the surface flake shaped clay particles. 

 

Natural molding sand is available in river beds or dug from pits. They possess an appreciable 
amount of clay and are used as received with addition of water. 

 

Synthetic sands are prepared by adding clay, water and other materials to silica sand so that 

desired strength and bonding properties are achieved which are not possessed by natural sands. 
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Properties of Molding Sand: 

 

The essential requirement of good molding sand is that it should produce sound castings which 

are free from defects. For producing sound castings, molding sand or mold should possess the 

following properties; to quote a few: 

 

Porosity or Permeability 

 

When molten metal is poured into a mold, gases and steam are passed through it. If they are not 
removed, casting defects such as blow holes will be formed. 

 

Flowability 

 

Flowability of molding sand refers to its ability to its ability, under externally applied forces 

(ramming), into deeper sections of the pattern and uniformly fill the flask. Flowability increases 

as clay and water content increase. 

 

Collapsibility 

 

Collapsibility is the property of sand that permits it to collapse (break) easily during its knockout 

from the castings. This property is particularly important for cores. This property depends on 

amount of the sand, clay and type of binder used. 

 

Adhesiveness 

 

Adhesiveness is the ability of a molding sand to stick on the surface of molding boxes. It is due 

to this property that the sand mass can be successfully held in a molding box and it does not fall 

out of the box when it is removed. 

 

Cohesiveness or Strength 

 

This is the ability of sand particles to stick together. Insufficient strength may lead to a collapse 
in the mold or its partial destruction during conveying, turning over or closing. 

 

Refractoriness 

 

The sand must be capable of withstanding the high temperature of the molten metal without 
fusing. 
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Types of Molding Sand: 

 

Molding sands are classified according to their use into a number of varieties. These are 
described as follows: 

 

Green Sand 

 

It is a mixture of silica sand with 18 to 30 % clay having a total water of 6 to 8 %. 

 

Dry Sand 

 

Green sand that has been dried or baked after the mold is made is called dry sand. 

 

Loam Sand 

 

Loam sand is high in clay, as much as 50 %. 

 

Facing Sand 

 

Facing sand forms the face of the mold. It is used directly next to the surface of the pattern and it 

comes into contact with the molten metal when the mold is poured. It is made of silica sand and 

clay, without the addition of used sand. 

 

Baking Sand 

 

Baking sand or floor sand is used to backup the facing sand and fill the whole volume of the 

flask. Old repeatedly used molding sand is mainly employed for this purpose. The baking sand is 

sometimes called black sand because of the fact that old, repeatedly used molding sand is black 

in color due to the addition of coal dust and burning on coming in contact with molten metal. 

 

Parting Sand 

 

Parting sand is used to keep the green sand from sticking to the pattern and also to allow the sand 

on the parting surface of the cope and drag to separate without clinging. This is clean clay free 

silica sand which serves the same purpose as parting dust. 

 

Core Sand 

 

The sand used for making cores is called as core sand and sometimes it is called as oil sand. This 

is silica sand mixed with core oil which is composed of linseed oil. Resin light mineral oil and 

other binding materials. 
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Pattern Materials: 
 
The selection of pattern materials depends primarily on the following factors. 

 

1. Service requirement, e.g. quantity, quality, and intricacy of casting i.e. minimum 
thickness, desired degree of accuracy, and finish required   

2. Type of production of castings and the type of molding process  

3. Possibility of design changes   
4. Number of castings to be produced, i.e. possibility of repeat orders  

 

To be good of its kind, pattern material should be: 

 

a. Easily worked, shaped, and joined   
b. Light in weight  

 
c. Strong, hard, and durable, so that it may be resistant to wear and abrasion, corrosion, and 

to chemical action   
d. Dimensionally stable in all situations   
e. Easily available at low cost   
f. Repairable and reused   
g. Able to take good surface finish  

 

The wide variety of pattern materials which meet these characteristics are wood and wood 
products; metal and alloys; plasters; plastics and rubber; and waxes. 

 

Types of Patterns: 
 
Single Piece or Solid Pattern 
 
 
In a simple solid pattern, one side is made flat which serves as a parting surface. In this case, the 

mold cavity will be entirely in the drag, and requires the more number of manual operations such 

as cutting the gating system and repairing of the mold. The shape of the single piece pattern is 

exactly same as that of casting. Single piece patterns are inexpensive and best suited for limited 

production. 
 
 
 
 
 
 
 
 
 
 

 

Fig: Split Pattern                                                                   Fig: Single Piece Pattern 
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Split Pattern 
 
Split pattern is made in two parts. One part producing the mold in drag and the other in cope. 

They are kept in position by dowel pins, and the split is usually arranged along the parting line to 

draw the pattern easily out of the mold before pouring of molten metal. Split piece patterns are 

used for intricate castings or castings of unusual shapes. 
 
 
Multi Piece Pattern 
 
 
Pattern with three or more parts is used for more complex castings. This type of pattern is known 

as multi piece pattern. It requires molding box with three parts. The middle one is called cheek. 
 
 
Loose Piece Pattern 
 
 
Loose piece pattern is used to produce the castings having projections in the sides. Such design 

makes impossible to draw the pattern from the mold. It is therefore necessary to make such 

projection in loose piece and fastened to main pattern by means of anchor pin. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Loose Piece Pattern 
 

Match Plate Pattern 

 

In this case, pattern in two halves is attached on opposite side of wooden or metal plate (match 

plate). Production efficiency and dimensional accuracy of castings can be generally improved by 

the use of these patterns. Several patterns for small castings (need not be same) can be mounted 

on one match plate. These are mostly used in machine molding as well as for producing large 

number of small castings by hand molding. 
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Fig: Sweep Pattern 

                                               Fig: Match Plate Pattern 

 

Sweep Pattern 

 

It is not a true pattern, but a template made of wood or metal revolving around a fixed axis in the 

mold shapes the sand to the desired contour. This eliminates the need for a large three 

dimensional pattern. It is suitable for producing simple symmetrical castings such as wheels, 

rims, and bell shapes. 
 
Runner: 

 

Runner is a horizontal channel that receives molten metal from the sprue base, and distributes to 

the ingates which carries metal to the mold. Runners are usually made trapezoidal in cross-

section. They are generally located in cope and ingates in the drag. This ensures that the slag and 

dross are trapped in the upper portion of runner and only molten metal enters into the mold. 
 
 
Runner Extension: 

 

The runner is often extended beyond the last ingate to retain inclusions and various refractory 

materials that may have been washed along the stream of molten metal. Also, it absorbs kinetic 

energy causing a smooth flow of metal into the mold cavity. 
 
Gates or Ingates: 
 
Gates or ingates are openings through which molten metal directly enters into the mold cavity. 

The gates should be designed such that the molten metal can flow steadily and quietly into the 

mold cavity. They should be easily removed from the casting after solidification. 
 
Tools and Equipment: 
 
Molding Board 
A molding board is a smooth wooden board on which the flask and pattern are placed when the 
mould is being made. The figure is shown below: 
 
 
 
 
 
 
 
 
Fig: Molding Boxes 
 

 



M R C E T                          ENGINEERING WORKSHOP MANUAL    B.TECH 1
ST

 YEAR 

 

DE 
D E P A R T M E N T  O F  M E C H A N I C A L  E N G I N E E R I N G  

 

Page 58 

Molding Boxes 
Sand moulds are prepared in specially constructed boxes called flasks. The purpose of flask is to 

impart the necessary rigidity and strength to the sand in molding. They are usually made in two 

parts, held in alignment by dowel pins. The top part is called the cope and the lower part the 

drag. These flasks can be made by wood or metal depending upon the size required and the 

purpose the flask must serve. 
 
Shovel 
A shovel is used for mixing and tempering molding sand and for moving the sand from the pile 
to the flask as shown in figure below: 
 
Riddle 
A riddle sometimes called a screen consists of a circular or square wooden frame fitted with a 

standard wire mesh at the bottom as shown in figure below. It is used to remove coarse sand 

particles and other foreign material from the foundry sand. 
 
 
 
 
 
 
 
 
Fig: Shovel                                         Fig: Riddle                                                   Fig: Rammers 

Rammer 

 

A hand rammer is used for packaging or ramming the sand into the mould. One of its ends, 

called the peen end, is wedge shaped and is used for packing sand in spaces, pockets and corners, 

in the early stages of ramming. The other end called the butt end, has a flat surface and is used 

for compacting the sand towards the end of molding as shown in below figure. 

Strike Edge or Strike-Off Bar 

 

It is a piece of metal or wood with straight edge as shown in below figure. It is used to remove 

excess sand from the mould after ramming, to provide a level surface 

 
Riser Pin 

 

It is a straight wooden pin used to make a hole in the cope over the mold cavity for the molten 

metal to rise-in and feed the casting to compensate the shrinkage that may take place during 

solidification. 

Sprue Pin 

 
It is a tapered wooden pin, as shown in below figure. It is used to make a hole in the cope 
through which the molten metal is poured into the mould. 
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Fig: Sprue Pin                            Fig: Slick 

 
 

              Fig: Lifters 

Slick 

 

It is a small double ended tool having a flat on one end and a spoon on the other end as shown in 

below figure. Slicks are used for repairing and finishing small surfaces of the mould. 
 
Lifter 
Lifters are made of thin sections of steel of various widths and lengths with one end bent at right 

angles as shown in below figure. They are used to clean and finish the bottom and sides of deep, 

narrow openings in moulds. 
 
Gate Cutter 
It is a small piece of tin plate shape as shown in below figure. This serves as a tool for cutting 
gates and runners in the mould. 
 
 
   
 
 

 

Fig: Gate Cutters                Fig: Vent Rods 

Fig: Draw Spikes 

 Vent Rod 
A vent rod or wire, as shown in below figure is used to make a series of small holes to permit 
gases to escape while the molten in being poured. 
 
Drawspike or Screw 

 

The draw spike is appointed steel rod, with a loop at one end. It is used to rap a draw patterns 

from the sand. Below figure shows two kinds of draw spikes. The draw spike is threaded on the 

end to engage metal patterns. 
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COURSE OBJECTIVE 

 

Objective: 

 

 The IT Workshop for engineers is a  training lab course spread over 60 hours. 
The modules include training on PC Hardware, Internet & World Wide Web and 
Productivity tools including  Word, Excel, Power Point and Publisher. 

 

PC Hardware introduces the students to a personal computer and its basic 
peripherals, the process of assembling a personal computer, installation of system 
software like MS Windows , Linux and the required device drivers. In addition 
hardware and software level troubleshooting process, tips and tricks would be 
covered. 

 

Internet & World Wide Web module introduces the different ways of hooking the PC 
on to the internet from home and workplace and effectively usage of the internet. 
Usage of web browsers, email, newsgroups and discussion forums would be 
covered. In addition, awareness of cyber hygiene, i.e., protecting the personal 
computer from getting infected with the viruses, worms and other cyber attacks would 
be introduced. 

 

Productivity tools module would enable the students in crafting professional word 
documents, excel spread sheets, power point presentations and personal web sites 
using the Microsoft suite of office tools and LaTeX. 
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WEEK1: 

Task 1: Generations of computers, Types of Computers, applications of computers Von 
Neumann architecture. Identify the different hardware components of a PC & their 
functions. 

 AIM: To identify the peripherals of a computer. 

Generations of Computers : 
First Generation (1940-1956) Vacuum Tubes 

The first computers used vacuum tubes for circuitry and magnetic drums for 
memory, and were often enormous, taking up entire rooms. They were very 
expensive to operate and in addition to using a great deal of electricity, generated a 
lot of heat, which was often the cause of malfunctions. The UNIVAC and ENIAC 
computers are examples of first-generation computing devices.  
 
Second Generation (1956-1963) Transistors 

Transistors replaced vacuum tubes in the second generation of computers. 
The transistor was invented in 1947 but did not see widespread use in computers 
until the late 1950s. The transistor was far superior to the vacuum tube, allowing 
computers to become smaller, faster, cheaper, more energy-efficient and more 
reliable than their first-generation predecessors.  
 
Third Generation (1964-1971) Integrated Circuits 

The development of the integrated circuit was the hallmark of the third 
generation of computers. Transistors were miniaturized and placed on silicon chips, 
called semiconductors, which drastically increased the speed and efficiency of 
computers. Instead of punched cards and printouts, users interacted with third 
generation computers through keyboards and monitors and interfaced with an 
operating system, which allowed the device to run many different applications at one 
time with a central program that monitored the memory. Computers for the first time 
became accessible to a mass audience because they were smaller and cheaper than 
their predecessors. 
 
Fourth Generation (1971-Present) Microprocessors 

The microprocessor brought the fourth generation of computers, as 
thousands of integrated circuits were built onto a single silicon chip. What in the first 
generation filled an entire room could now fit in the palm of the hand. The Intel 4004 
chip, developed in 1971, located all the components of the computer—from the 
central processing unit and memory to input/output controls—on a single chip. In 
1981 IBM introduced its first computer for the home user, and in 1984 Apple 
introduced the Macintosh.  
 
Fifth Generation (Present and Beyond) Artificial Intelligence 

Fifth generation computing devices, based on artificial intelligence, are still in 
development, though there are some applications, such as voice recognition, that are 
being used today. The use of parallel processing and superconductors is helping to 
make artificial intelligence a reality. Quantum computation and molecular and 
nanotechnology will radically change the face of computers in years to come. The 
goal of fifth-generation computing is to develop devices that respond to natural 
language input and are capable of learning and self-organization. 
 
Computer Types 
Many types of computers exist that differ widely in Size, Cost, Computational Power 
and intended Use 

http://www.webopedia.com/TERM/M/magnetic_drum.html
http://www.webopedia.com/TERM/M/memory.html
http://www.webopedia.com/TERM/E/ENIAC.html
http://www.webopedia.com/TERM/T/transistor.html
http://www.webopedia.com/TERM/I/integrated_circuit_IC.html
http://www.webopedia.com/TERM/S/silicon.html
http://webopedia.com/TERM/C/chip.html
http://webopedia.com/TERM/S/semiconductor.html
http://www.webopedia.com/TERM/K/keyboard.html
http://www.webopedia.com/TERM/M/monitor.html
http://www.webopedia.com/TERM/I/interface.html
http://www.webopedia.com/TERM/O/operating_system.html
http://www.webopedia.com/TERM/A/application.html
http://www.webopedia.com/TERM/M/microprocessor.html
http://www.webopedia.com/TERM/C/CPU.html
http://www.webopedia.com/TERM/I/IBM.html
http://webopedia.com/TERM/A/Apple_Computer.html
http://webopedia.com/TERM/A/artificial_intelligence.html
http://webopedia.com/TERM/V/voice_recognition.html
http://webopedia.com/TERM/P/parallel_processing.html
http://webopedia.com/TERM/Q/quantum_computing.html
http://webopedia.com/TERM/N/nanotechnology.html
http://webopedia.com/TERM/N/natural_language.html
http://webopedia.com/TERM/N/natural_language.html
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1. Personal Computer/ Desktop computers: which is found in homes, Schools 

and business offices 

2. Portable Notebook Computers: A compact version of PC with all of these 

components packaged into a single unit the size of a thin briefcase. 

3. Work Stations: with high-resolution graphics I/O capability. Used in the 

engineering applications, Interactive design works. 

4. Enterprise System Servers: used for business data processing in medium to 

large corporations that require much more computing power and storage 

capacity than workstations. 

5. Super Computers: Contain sizable database storage units and are capable 

of handling large volumes of requests to access the data. 

6. Hand-held computers: A portable computer that is small enough to be held 

in one’s hand. Although extremely convenient to carry, handheld computers 
have not replaced notebook computers because of their small keyboards and 

screens.  Hand-held computers are also called PDAs, palmtops and pocket 

computers 

 

Block Diagram of Computer : 

 

A computer can process data, pictures, sound and graphics. They can solve highly 
complicated problems quickly and accurately. 

InputUnit: 
Computers need to receive data and instruction in order to solve any problem. 
Therefore we need to input the data and instructions into the computers. The input 
unit consists of one or more input devices. Keyboard is the one of the most 
commonly used input device.  

StorageUnit: 
The storage unit of the computer holds data and instructions that are entered through 
the input unit, before they are processed 

1. Primary Storage: Stores and provides very fast.  

2. Secondary Storage: Secondary storage is used like an archive.  

MemorySize: 
All digital computers use the binary system, i.e. 0’s and 1’s. The size of the 
primary storage is specified in KB (Kilobytes) or MB (Megabyte). One KB is equal 
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to 1024 bytes and one MB is equal to 1000KB. The size of the primary storage in 
a typical PC usually starts at 16MB. PCs having 32 MB, 48MB, 128 MB, 256MB 
memory are quite common. 

Output Unit: 
The output unit of a computer provides the information and results of a computation 
to outside world. Printers, Visual Display Unit (VDU) are the commonly used output 
devices.. 

Arithmetic Logical Unit: 

All calculations are performed in the Arithmetic Logic Unit (ALU) of the computer.. 
The ALU can perform basic operations such as addition, subtraction, multiplication, 
division, etc and does logic operations viz, >, <, =, ‘etc.  

Control Unit: 

It controls all other units in the computer. The control unit instructs the input unit, 
where to store the data after receiving it from the user.  

Central Processing Unit: 
The control unit and ALU of the computer are together known as the Central 
Processing Unit (CPU). The CPU is like brain performs the following functions: 
• It performs all calculations. 
• It takes all decisions. 
• It controls all units of the computer. 
Introduction to Computer Hardware: 

Hardware is the physical appearance of the devices or tools. It is what which we can 
touch and feel. 

Computer Hardware consists of the Monitor, CPU, Keyboard, Mouse and all other 
devices connected to the computer either externally or internally. 

A typical computer (personal computer, PC) consists of a desktop or tower case 
(chassis) and the following parts: 

1. CPU The central processing unit contains the heart of any computer, the 
processor. The processor is fitted on to a Mother Board. The Mother Board 
contains various components, which support the functioning of a PC.  

 

2. System board/Motherboard which holds the Processor, Random Access 
Memory and other parts, and has slots for expansion cards  
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3. RAM (Random Access Memory)- For program execution and short term data-
storage, so the computer doesn't have to take the time to access the hard drive to 
find something. More RAM can contribute to a faster PC.  

The main memory is used for the following purposes: 

1. Storage of the copy of the main software program that controls the general 
operation of the computer. This copy is loaded on to the main memory when 
the computer is turned on, and it stays there as long as the computer is on.  

2. Temporary storage of a copy of application program instruction, to be 
received by CPU for interpretation and processing or execution.  

3. Temporary storage of data that has been input from the key board, until 
instructions call for the data to be transferred in to CPU for processing.  

ROM (Read Only Memory) 

Instructions which are critical to the operation of a computer are stored 
permanently on Read only Memory. (ROM) chip installed by the manufacturer inside 
the computer. This ROM chip is also called firm ware, retains instructions in a 
permanently accessible nonvolatile form. When the power in the computer is turned 
off, the instructions stored in ROM are not lost. 
It is necessary and also convenient to have instructions stored in ROM. lowered the 
cost to the point where manufacturers are beginning to include additional software 
instructions. 

Differences between  ROM &RAM 

ROM (Read only memory)  

1. You can only read the data.  

2. Data can’t be written every time, to write the data we need PROM, EPROM, 
OR EEPROM.  



DEPARTMENT OF CSE IT WORKSHOP LAB MANUAL  

 

8 

 

3. ROM is non volatile in nature. The data stored in ROM is permanent in 
nature.  

4. Size of the ROM has nothing to do with processing.  

RAM (Random access memory):  

1. You can read and write data on the chip.  

2. RAM has volatile memory. It looses its contents when the power is switched 
off.  

3. Size of the RAM makes difference in the processing i.e., bigger the size of the 
RAM more is the speed of processing.  

4. The data can be read and written at anytime.  

Dynamic RAM (DRAM) 

 

o Synchronous DRAM (SDRAM) 

 

o Static RAM (SRAM) 

 

4.Buses : PCI bus, PCI-E bus, ISA bus (outdated), USB, AGP 
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5. Power Supply - a case that holds a transformer, voltage control and fan 

 

 

 

6. Storage controllers, of IDE, SCSI or other type, that control hard disk, floppy 
disk, CD-ROM and other drives; the controllers sit directly on the motherboard 
(on-board) or on expansion cards 

7.  Video display controller that produces the output for the computer display 

8.  computer bus controllers (parallel, serial, USB, Fire wire) to connect the 
computer to external peripheral devices such as printers or scanners 

9.  Some type of a removable media writer:  

10.  CD - the most common type of removable media, cheap but fragile.  

      CD-ROM, , CD-RW,  CD-R,  DVD,  DVD-ROM.,  DVD-RW,  DVD-R,  
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11. Floppy disk 

 

Floppy Disk Drive 

 

12. Tape Drive - mainly for backup and long-term storage 

13. Internal storage - keeps data inside the computer for later use. 

14. Hard disk - for medium-term storage of data. 

http://en.wikipedia.org/wiki/Image:CDR-large.jpg
http://en.wikipedia.org/wiki/Image:Floppy_disk_90mm.JPG
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15. Disk array controller 

 

16. Sound card - translates signals from the system board into analog voltage 
levels, and has terminals to plug in speakers. 

 

17. Networking - to connect the computer to the Internet and/or other computers 
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18. Modem - for dial-up connections 

 

19. Network card - for DSL(Digital Subscriber Line)/Cable internet, and/or 
connecting to other computers. 

 

20.Other peripherals: In addition, hardware can include external components of 
a computer system. The following are either standard or very common. 

Standard input devices:    Keyboard 

 

http://en.wikipedia.org/wiki/Image:Network_card.jpg
http://en.wikipedia.org/wiki/Image:QWERTY.png
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Mouse 

 

Alternate input devices: 

 Pens,Touch screens,Game controllers(joy stick),Touch pad,Trackball. 

Optical  input devices:  Barcode reader, Image scanners. 

Audio visual input devices: Microphones, Video input ,Digital cameras 

  

21. Output : The output devices are: 

Standard output devices: Monitor 

Types of monitors 

CRT(cathode ray tube) monitors 
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LCD(liquid crystal display) monitors 

                    

Printer 

Types of printers 

Impact printers: An impact printer create an image by using pins or hammers to 
press an inked ribbon against the paper.ex. Dot matrix printer. 

Non impact printers: This type uses other means to create an image for example 
in ink jet printers tiny nozzles are used to spray droplets of ink on the page.ex: Ink 

jet printer 

 

Laser  

Printer 

                               

Dot- Matrix printer: 

Inkjet printer 
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Other output devices:  

Speakers, LCD projectors, Networking, Network card 

Speakers 

 

LCD Projectors: 
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TASK 2: 

Assembling and disassembling the PC back to working condition.  

AIM: To assemble and disassemble the system 

Safety Precautions: 

1. Beware of electrostatic discharge (ESO) 

2. Build computer on a hard surface, away from concepts. 

3. Wear shoes and the short sleeved cotton wear. 

4. Use Phillips, head screw driver. 

5. Keep the components away from moisture. 

6. Avoid using pressure while installing. 

Steps for Assembling 

 

 Fix the SMPS on the cabinet of PC using the screws provided. 

 Fix the motherboard on the cabinet of PC using the screws provided. 

 Connect the power cables from SMPS to motherboard. 

 Insert the preprocessor into the slot provided such that the corner with no pin 
coincide with corner without pinhole on motherboard. 

 Apply the appropriate adhesive  on the processor for fixing the processor fan. 

 Fix the processor fan on the processor and use clips on it to keep it firm. 

 Connect the power cable to the processor fan 

 Insert the RAM card into the slots provided on the motherboard. 

 Set the jumpers setting on the hard disc drive. 

 Fix the hard disc drive in the space provided in the PC cabinet using screws 
provided. 

 Fix the FDD in the space provided in the PC cabinet using screws provided. 

 Fix the CD-ROM in the space provided in the PC cabinet using screws 
provided. 

 Connect the FDD,HDD, CD-ROM drive to motherboard using flat ribbon. 

 Connect power supply to the HDD, FDD, CD-ROM drive using the cables 
from the SMPS. 

 Connect wires of speakers and lights of cabinet to the motherboard. 
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 Connect the network interface and other cards to motherboard by inserting in 
right slots and fix them in cabinet using the screws provided. 

 Place the cabinet in right position. 

 Fix the doors of the cabinet. 

 Connect the data cable of monitor to the CPU. 

 Connect the keyboard cable to the CPU. 

 Connect the mouse cable to the CPU. 

 Connect other devices to CPU. 

 Connect the LAN cable to NIC in CPU. 

 Connect the power supply to CPU. 

 Connect the power supply to Monitor. 

 Switch on the computer after giving the power supply.  

 

Getting the Cabinet ready:- 

1. Check how to open the cabinet and determine where to fix the 
components. 

2. Determine if the case has the appropriate risers installed. 

Preparing to fit the Components: 

1.  Network adapter drive. 

2.  Floppy disk drive. 

3.  Ribbon cables. 

4.  Hard disk. 

5.  CD-ROM Drive. 

6.  RAM 

7.  CPU 

8.  Heat sink / cooler / fan. 

9.  Mother board. 

10.  Screws. 

Fitting the Mother board. 



DEPARTMENT OF CSE IT WORKSHOP LAB MANUAL  

 

18 

 

1. Line up the patch on the motherboard ( ps/l, USB, etc ) with the 
appropriate holes in the block panel I/O shield of the case. 

2. Check the points where you and to install 

3. Install them and make the mother board sit on them and fix screws if 
required. 

Mother board parts: 

1. ACR slot. 

2. PCI Slot. 

3. AGP Slot. 

4. ATX Connectors. 

5. CPU Fan. 

6. Chipset North Bridge. 

7.  CPU socket. 

8. Floppy. 

9. System memory. 

10.  Chipset south bridge. 

11.   Panel connector. 

12.  Power supply. 

13.  IDE connectors. 

ATX Connectors: 

1. PS, Mouse. 

2. Key board. 

3. USB. 

4. Parallel ( Prints ) 

5. Serial COM1. 

6. Serial COM 2. 

7. Joystick. 

8. Sound. 

 

Fitting the processor: 
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   1. Raise the small lever at the side of the socket. 

  2. Notice that there is a pin missing at one corner, determine the direction to 
fit in the processor. 

3. You should not force the CPU. When inserting it. All pins should slide 
smoothly into the socket. 

4. Lock the lever back down. 

5. Install the heat sink over it (Different type for each processor). Heat sink / 
CPU fan.  

 Fitting the RAM: 

1. The RAM must be suitable for motherboard. 

2. There are currently 3 types of RAM available. 

a) SD RAM. 

b) DDR SD RAM. 

c) RD RAM. 

3. The mother board’s chipset determines which type of RAM may be used. 

Installing the PCI Cards: 

1. Most of the cards are inbuilt these days. 

2. NIL, Sound Cards etc. are fitted into PCI slots. 

Fitting the hard disk and Floppy disk: 

1. Place the floppy and hard disks in their slots. 

2. Leave some space above HDD to prevent heat building. 

3. Check the jumper configuration. 

4. Fix the screws. 

Installing the CD-ROM Drives: 

1. CD-ROM drive is similar to installing a hard disk. 

2. 1ST check that the jumper configuration is correct. 

3. Fix the screw. 

 

Connecting the ribbon Cables:- 

1. Attach the long end of the cable to the IDEU connector on the 
motherboard first. 
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2. The red stripe on the IDE cable should be facing the CD Power. 

Powering the driver and motherboard: 

       Connecting the cables for the case front pane 

        1. SD, SPK or SPEAK: The loud speakers o/p. it has 4 pins. 

        2. RS, RE, RS or RESET: Connect the two pin Reset cable here. 

3. PWR, PW, PWSW, PS or power SW: Power switch, the pc’s on (switch, the 
plug is two pin ). 

4. PWLED, PWRLED or Power LED: The light emitting diode on the front panel 
of the case illuminates when the computer is switched on. It’s a 2-pin cable. 

       5. HD, HDD, and LED: These two pins connect to the cable for the hard disk 
activity LED. 

Final Check:- 

1. Mother board jumper configurations are the settings for the processor 
operator. 

2. Drive jumper settings, master/ slave correct? 

3. Are the processor, RAM modules and plug in cards finally seated in there 
sockets? 

4. Did you plug all the cables in? Do they all fit really? 

5. Have you frightened all the screws in plug- in cards or fitted the clips? 

6. Are the drive secure? 

7. Have u connected the power cables to all driver? 

Powering up for the first time: 

1. Ensure that no wires are touching the CPU heat sink fan. 

2. Plug your monitor, mouse and keyboard. 

3. Plug in power card and switch the power supply. 

4. If everything is connected as it should be 

 All system, fans should start spinning. 

 U should hear a single beep and after about 5-10 sec. 

 Amber light on monitor should go green. 

 You will see computer start to boot with a memory check. 

 Now check front LED’S to see if u plugged them in correctly. 
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 Check all other buttons. 

 Power afford change any wrong settings. 

Steps for Disassembling 

 Switch of the power supply 

 Disconnect the power supply cable from monitor. 

 Disconnect the power supply cable from CPU. 

 Disconnect the LAN cable to NIC in CPU. 

 Disconnect the other devices in CPU such as printers. 

 Disconnect the mouse cable from CPU. 

 Disconnect the keyboard cable from CPU. 

 Disconnect data cable of monitor from CPU. 

 Remove the doors of cabinet. 

 Place the cabinet such that motherboard faces the ceiling. 

 Disconnect the NIC and other cards from mother board by removing from 
slots and unscrewing from cabinet. 

 Disconnect the wires of speakers from mother board. 

 Remove power supply cables from HDD, FDD, CD-ROM drive etc. 

 Disconnect the HDD, FDD, CD-ROM drive from mother board by removing  
flat ribbon cable. 

 Remove CR-ROM from cabinet. 

 Remove the FDD from cabinet by unscrewing it. 

 Remove the HDD from cabinet by unscrewing it. 

 Removing RAM cards from slots on mother board. 

 Disconnect the power cables from processor fan. 

 Remove the processor fan by unlocking clips on it. 

 Disconnect the power cables from SMPS on power cabinet. 

 Remove mother board from cabinet by unscrewing it. 

 Remove the SMPS from cabinet of PC by unscrewing it. 
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Week 2: 
 

TASK3: Install MS windows on the personal computer INSTALLATION OF 

WINDOWS XP:  

AIM: To  install Windows XP 

Windows XP (codename Whistler, also known as Windows NT 5.1) is the latest 
desktop version of the Microsoft Windows operating system. It was made publicly 
available on October 25, 2001. Two editions of Windows XP are most commonly 
available: Windows XP Home Edition which is targeted at home users and Windows 
XP Professional which has additional features such as dual-processor support and 
the ability to join a domain, a grouping of centrally managed Windows computers. 
The letters "XP" originate from the word "Experience".  

Step 1 : Prepare The Boot Sequence 

Insert the windows XP cd in your cdrom and than go to the BIOS by hitting “DEL” or 
“F12″ when your system in powering on. Go to Boot order and make sure cdrom is 
on the first place. 
Save settings and restart your computer. 

Once you have successfully booted from the CD, you will see the Windows XP 
“Welcome to Setup” screen. Press ENTER to begin the setup process. 
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Step 2: Accept the license agreement 

When you see the Windows XP license agreement press F8 to accept it and 
proceed. 

 

Step 3: Searching for Previous Versions of Windows XP 

Setup will search for existing Windows installations. You will see the next “repair or 
install fresh copy” screen appear only if a Windows installation currently exists on 
your machine. If you’re installing on a brand-new hard drive, skip to Step 5. 
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Step 4:Continue Installing a Fresh Copy 

Press ESC. You will be given a list of partitions available on your hard drive. 

 

 

Step 5: Partitions 

If there are multiple partitions on your hard drive, or you have multiple hard drives in 
the computer, use the UP or DOWN arrow keys to choose your install partition. 
Please note that your system partition needs to be a primary partition (usually the 
first partition that shows up in the list), not a logical partition. 
The partition should be at least 10 GB in size. Make sure that all the data you need 
from this partition is copied elsewhere, because it will be deleted. 

Once you have selected the right partition selected, press ENTER. You will see the 
next “you already have a system installed” screen only if you already have Windows 
installed on this partition.If you are installing on a brand-new hard drive,skip to Step 
7. 
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Step 6: Continue Installing On The Selected Drive 

Press C to continue. You will be given a list of install options 

 
Step 7: Format The Selected Partition 

Select the option to “Format the partition using the NTFS file system (quick) and 
press ENTER.You will receive a warning about formatting the drive unless the drive 
is brand-new. 

 

Step 8: Continue With The Format 

Press F to continue formatting selected partition. If you still haven’t backed up, this is 
the last change to backup your important data, after this step you will not to able to 
go back and restore your data. 

 
Step 9: Copying Files 
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After the format setup will automatically copy files and restart your computer. Go to 
BIOS and remove cdrom from first boot device. Start your computer. 

/  

STEP 10: Setup will show a progress box and reboot when copying files is complete. 

When you see the "Press any Key to Reboot" do not Press any Key. If CD boots 
anyway, remove CD and reboot. 

 

Step 11:From this point, you will follow the on screen prompts. 
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Step 12:If you live outside the US, you will probably need to modify the default 
settings. 
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Step 13:If you live outside the US, you will probably need to modify the default 
settings. 

 

Step14: Personalize your XP Enter your Name Organization. 
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Step 15:Enter the Product Key. The Key is located on the back of the CD folder in the 
Retail versions, and on a holographic label with the OEM versions purchased with a 
piece of hardware. Write this key down and secure it in a safe place in case the 
original is misplaced or destroyed through natural causes .  

 

Step 16:Choose a name for the computer, this should be a unique name for the 
computer, especially if it is to be connected to a network. In Pro, you are given the 
option of creating a password or leaving it blank. 

 

Step 17:Set your Time Zone and Time and Date. 
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Step 18: If detected you will have the choice to choose a typical  configuration or 
custom. Choose typical if you are unsure. 

 

Step 19: For home you will choose your workgroup, if a network is already 
established and you intend to connect to it, use the existing workgroup name, 
otherwise, I suggest using the default. 

 

Step 20:For Pro, the same goes for Pro as suggested for Home, but you will have the 
choice to join a Domain, if you do not have a Domain or do not know leave blank. 

Setup will continue and reboot when completed ignore the "Press Any Key". 

The XP loading window will now display after reboot. 

Viva Questions: 

1) NTFS stands for---------? 

2) What is the use of product key in the installation process of a software? 

3) How many characters does a product key contain fro windows XP? 

4) Describe different kinds of Microsoft Operating systems? 
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TASK-4 

Exposure to Basic commands in MS-DOS commands like ver, vol, date, time, cls, 
dir, md, cd, path, rd, copy con, type, copy, move, del, ren, prompt, ipconfig etc. 

Directory Structure of DOS: One thing is to be kept in mind is that a directory can 
have as many child (sub) directories, but the child directory can have only one parent 
directory. (DIR) 

These internal commands are further grouped according to their properties. These 
are as follows. 

General purpose File related commands Directory related commands 

1. CLS 
2. DIR  
3. VER 
4. VOL 
5. DATE 
6. TIME 

7. COPY CON 
8. TYPE 
9. COPY 
10. REN 
11. DEL 

12. MD 
13. CD 
14. RD 

General purpose commands  

1. CLS:- (Clear the screen) This command is used to clear the screen or wipe out 
every thing written on the screen. 

Syntax:-    C:\> CLS   and press Enter 

2. DIR:- (Directory) Dir command is used for listing files and directories present in the 
current disk. 

Syntax:-  C:\> DIR [/options] 

Example:-   C:\> DIR /P 

  

\ 

http://www.rcppmail.org/DOS/Internal_commands.htm#CLS
http://www.rcppmail.org/DOS/Internal_commands.htm#DIR
http://www.rcppmail.org/DOS/Internal_commands.htm#VER
http://www.rcppmail.org/DOS/Internal_commands.htm#VOL
http://www.rcppmail.org/DOS/Internal_commands.htm#DATE
http://www.rcppmail.org/DOS/Internal_commands.htm#TIME
http://www.rcppmail.org/DOS/Internal_commands.htm#COPY%20CON
http://www.rcppmail.org/DOS/Internal_commands.htm#TYPE
http://www.rcppmail.org/DOS/Internal_commands.htm#COPY
http://www.rcppmail.org/DOS/Internal_commands.htm#REn
http://www.rcppmail.org/DOS/Internal_commands.htm#DEL
http://www.rcppmail.org/DOS/Internal_commands.htm#MD
http://www.rcppmail.org/DOS/Internal_commands.htm#CD3
http://www.rcppmail.org/DOS/Internal_commands.htm#RD
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Options:- 

/P  Page wise 

/W  Widths wise 

/S  List all files and directory of subdirectories 

/AH  Display directory with hidden files  

/AS  Display directory with system files 

/AD  Display only directories present in current drive 

3. VER:-(Version) Version numbers indicates that which edition of DOS we are 
working on. 

Syntax:-  C:\> VER   press enter 

Output:- 
C:\>VER 
Windows 98 [Version 4.10.2222] 

4. VOL:-(Volume) Displays the disk volume label and serial number, if it exist.  

Syntax:- C:\> VOL  press enter 
Output:-C:\>VOL 
 
Volume in drive C is JAI 
Volume Serial Number is 3E42-1907 

5. DATE:- Display the current Date  

Syntax:-  C:\> DATE 
C:\>DATE 
Current date is Fri 02-15-2002 
Enter new date (mm-dd-yy): 
 
6. TIME:- Display current time 

Syntax:- C:\> TIME 
C:\>TIME 
Current time is 8:38:47.70a 
Enter new time: 
 
Type TIME with no parameters to display the current time setting and a prompt for a 
new one. Press ENTER to keep the same time.  

Note:- We enter the time in the format of 24 hour clock.  

File related commands 

7. COPY CON:- This command gives the facility to create a new text file. 
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Syntax:-  C:\> COPY CON <Filename> 
C:\>COPY CON Rose.txt 
A clock in a office can never get stolen 
Too many employees watch it all the time 
^Z 
1 file(s) copied 
 
After copy con we must specify a suitable file name. Press enter. Start typing the 
informations of the file. After gathering the information we press ^Z (CTRL+Z) button 
or F6 button to save the file. After pressing enter key computer will show a message 
like 1 file(s) copied. This means that file is stored in the disk. Suppose we don't want 
to save the file or we just want to abort from file creation job, then we simply press ^C 
(CTRL+C) button to abort without saving the file, intend of pressing ^Z button. 

Notes:-  1. Never forget to give a suitable filename 
              2. You can use extension as .TXT for denoting the file as Text file. 

8. TYPE:- This command is used to display the contents or text of any file to the 
display device. 

Syntax:- C:\> TYPE <Filename> 
A:\>TYPE GULAB.TXT 
A clock in a office can never get stolen 
Too many employees watch it all the time 

9. COPY :-  Copy command is used for copy any file to another location or to copy 
the files to another directory. This command may also be used for copying any file to 
another disk with different file name. 

Syntax:-  C:\> COPY <Source 
filename> <Target file name> 
 C:\>COPY ROSE.TXT ROSE.MSG 
         1 file(s) copied 

- 

  

10. REN:- (Rename) This command is used to change the name of any file or 
directory.  

Syntax:- C:\> REN <Source filename> <Target filename> 
C:\>REN ROSE.TXT GULBAL.TXT 
If we get successfully C:\ that means filename or directory name is get changed. 
Either it will show the error message.  

To changing the filename present in floppy disk 
C:\>REN A:\ROSE.TXT GULAB.TXT 
Note that you cannot specify a new drive or path for your destination. 

11. DEL:- This command is used for erasing any file from the disk.  

Syntax:- C:\> DEL <Filename> 
C:\>DEL LOTUS.TXT 
If it successfully erase the file from dosk then C:\> prompt will be appear, either 
computer will show an error message.  

Note:- /P option is used for permission before deleting the file.  
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Directory related commands 

12. MD:- (Make Directory)- This command allows to create a new directory.  

Syntax:- C:\> MD <Dirname> 
C:\> MD REPORT 
C:\>  

Now this directory can be used for keeping various sort of reports. Under this 
directory we can create another directory which is known as subdirectory.  

13. CD:- (Change Directory):- We can enter or exit from any directory using this 
command.  

Syntax:- To access any directory 
C:\> CD <Directory name> 
C:\> CD REPORT 
C:\REPORT>  

Prompt will change with the directory name. If we keep two dots after CD command 
than we will exit from the directory.  

Syntax:-C:\> CD.. 
C:\REPORT> CD.. 
C:\>  

14. RD:-(Remove directory):- This command is used when we want to remove any 
unusable directory form our disk. 

Syntax:- C:\> RD <Directory name> 
C:\> RD REPORT 

15. PATH:- This command is used for display or sets directories for executable files. 

Synatx:- C:\> PATH  
This command display current path settings. 
 
C:\> PATH=C:\WINDOWS\COMMAND;C:\WINDOWS\;C:\TC 
this command will sets the directories windows, the command subfolder of windows 
and TC folder for executable files. Operating system will look for executable files in 
these directories. 

     Example:- C:\> DIR/?  or  C:\> COPY/? 

16. Prompt allows the user to set a new DOS prompt instead of usual C:\> or A:\>; 
eg C:\> prompt pcc; Prompt$p$g - this allows you to reset default prompt; Prompt $d 
(current date); Prompt $t (current time); 

17. MOVE:- Move command is used for moving one file or multiple files from one 
location to another location or from one disk to another disk. 

Syntax:- C:\> MOVE  <file name>  <path name> 
C:\SONGS> MOVE   *.MP3   C:\ SONGS\OLD SONGS\ 
 
C:\> 
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18. ipconfig: internet protocol configuration(to display the IP address) 

Ethernet adapter Local Area Connection: 

Connection-specific DNS Suffix . : hsd1.ut.comcast.net. 
IP Address. . . . . . . . . . . . : 192.168.201.245 
Subnet Mask . . . . . . . . . . . : 255.255.255.0 
Default Gateway . . . . . . . . . : 192.168.201.1 

ipconfig /all 

Windows IP Configuration 
 
Host Name . . . . . . . . . : COMPUTERH1 
DNS Servers . . . . . . . . : 123.45.67.8 
111.111.111.1 
111.111.111.1 
Node type . . . . . . . . . : Broadcast 
NetBIOS Scope ID. . . . . . : 
IP Routing Enabled. . . . . : No 
WINS Proxy Enabled. . . . . : No 
NetBIOS Resolution Uses DNS : No 
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Week 3: 
 
Task 5:  Installation of operating systems LINUX and different packages on a PC. 

 FEDORA  Linux Installation Process: 
1. LINUX BOOT OPTIONS  

Actually Linux can be installed in two different modes, based on the requirement of 
the user.  

Graphical Mode. & Text Mode. 

Graphical Mode - In this you can work with Graphical Interface (i.e., it supports 
mouse and Icons ). By clicking the icon with the mouse, you can perform related 
action. 

To install Linux in Graphical Mode Press Enter. 

 

Text Mode - In this mode you have to interact with character based interface ( i.e., 
Command prompt ). 

To install Linux in Text Mode Type : Linux text and Press Enter. 

After selecting the mode of installation, it goes on detecting the basic input output 
devices and file systems. And at last it displays a screen asking whether to test the 
CD inserted to install or to Skip the test process. Otherwise we can test total 
installation CD’s. 

 

On completion of testing the CD’s, it goes on loading an installation program 
“ANACONDA” which helps us in the installation of the remaining part. 

2 WELCOME TO INSTALLATION PROCESS  
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It starts with the display of the welcome screen containing the online help , 
and four buttons to help us in the different activities in the installation process. 

Hide Help/Show Help - Which helps you in guiding the installation process, 
which can be activated or hidden. 

Release Notes - Which contain the Basic Hardware Requirements that are necessary 
for the installation of the Red Linux 9.0 and some other post-installation issues. 

Next - This button allows you to go to next step of the installation process by the 
current step. 

Back - This button allows you to move back of the installation process to make any 
changes that previously mentioned. 

Action: click “Next” to move to next screen. 
3. SELECTING A LANGUAGE 

It displays a screen containing various languages, to select a language you would 
like to use during this installation process. 

 

4. CONFIGURING KEYBOARD AND MOUSE  

Here we need to select our own keyboard and mouse layouts which will help you to 
interactively proceed in the installation process. 

At this point of time it displays you the different types of keyboard layouts. So that 
you can select your desired one that you would like to use for the system. 

And also choose the appropriate Mouse for the system, based on the following: 
Select the exact mouse type among the available. 
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5. TYPE OF INSTALLATION:  

There are different installation types that are available which will enable you to select 
that will best meet your needs. 

There are four different types of installations are there – 

Personal Desktop  

- You select it for personal computers or laptops, select this installation type to install 
a graphical desktop environment and create a system ideal for home or desktop use.  

Work Station  

- This option installs a graphical desktop environment with tools for software 
development and system administration.  

Server  

- If you would like to set up file sharing, print sharing, and web services and 
additional services.  
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Custom  

- Select this installation type to gain complete control over the installation process,  

Including software package selection and authentication preferences.: 

 

6. PARTITIONING THE DISK  

Partitioning the disk can be done either automatically or manually. 
AUTOMATIC PARTITIONING  
– By selecting automatic portioning, you will not have to use partitioning tools to 
assign mount points, create partitions, or allocate space for your installation. 
Automatic partitioning allows you to have some control concerning what data is 
removed from your system.  

To remove only Linux partitions remove all Linux partitions on this system. 

To remove all partitions on your hard drive, select remove all partitions on this 
system. 

To retain your current data and partitions, assuming you have enough free 
space available on your hard disk, select Keep all partitions and use existing free 
space. 

You can review the partitions that are automatically created using the check box 
Review (and modify if needed) the partitions created. 
 
MANUAL PARTITIONING  
– To partition manually, choose the Disk Druid partitioning Tool. For the manual 
partitioning of Linux installation you need assign disk space for the three compulsory 
file systems, they are /boot, /(root), swap  
/boot  

- This type of partition should of ext3 file system type. For this /boot partition a 
minimum of about 150MB is necessary.  

Swap  

The swap partition should of swap file system type having a minimum of the double 
the RAM available on your system. (i.e., if, RAM is of 512MB, your swap should be a 
minimum of 1024MB.) 
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/(root) –  

The symbol ‘/’ stands for the root. This root partition should be a minimum of 5GB. 
And you can also increase it based on your availability to increase your system 
performance.  

To add a new partition Just click on the NEW button and select your mount point (i.e., 
directory of partition ex: /, /boot, /user, etc., ), select your file system type among the 
available i.e. Ext3, ext2, swap, vfat, etc., ), and you have different additional size 
options like Fixed Size, Fill all space up to(MB), Fill to maximum allowable size. And 
also you can make a partition to be primary partition and check for the bad blocks on 
each partition.  

Now we have to partition our hard disk. You can choose to let the Fedora installer do 
the partitioning, or you can do it yourself. I want to create a small /boot partition (less 
than 100 MB) with the file system ext3, a swap partition and a huge / partition (again 
with ext3): 
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Now the boot loader GRUB will be installed. You can leave the default settings 
unchanged and click on Next: 

7. BOOT LOADER CONFIGURATION  
The GRUB boot loader will allow you to boot other operating systems. It will 

allow you to select an operating system to boot from the list. To add another 
operating system. You can also add other operating systems that are not detected 
automatically.  
For greater system security, you can set your password for the boot loader. To avoid 
unauthorized changes to the system. 
You can also change the type of boot loader other than GRUB, among the available 
like LILO. And also you can avoid to install boot loader. 

 
8. NETWORK CONFIGURATION  

With this option you can set your Network devices manually or using DHCP 
(Dynamic Host Configuration Protocol) which will automatically takes default IP 
address, and Net mask addresses. The DHCP also set your Hostname. 
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9. FIREWALL CONFIGURATION  
A firewall configuration is set between yours computer and network. And decides 
which resources of your computer are accessible by the remote users on the 
network. On proper configuration of firewall we can set different security levels for the 
system.  
By using firewalls we can avoid any entrusted passage of data and also we can set 
our own protocol supports. 

 
10 . ADDITIONAL LANGUAGE SUPPORT  

This screen shows different additional languages for installation. These additional 
languages can be used to switch after installation process. 
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11. SELECTING A TIME ZONE  

To set our time zone we can do it either by selecting computers physical location or 
by your time zone’s offset from Universal Time, Coordinated. This screen shows two 
tabs namely location and UTC Offset. First tab offers you the ability to configure by 
location. Second tab allows to set UTC Offset. 

 

12. ROOT PASSWORD SETTINGS  
The Root password is for avoiding any unauthorized access to Administration 
settings . 

 
13. PERSONAL DESKTOP DEFAULTS  
With this screen we can accept the default package list or we can customize the set 
of packages to be installed. 
 
14. SELECTION OF PACKAGES TO INSTALL 
On selecting the customized set of packages we can select our own selection of 
desktops, applications, servers, development tools and system tools to be installed 
among the available. 
And also we have an option to select a minimal set of packages and all the packages 
that are available which will install complete set of packages(about 1400) which will 
require about 4850 MB of space. 
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15. ABOUT TO INSTALL  

This is the final step to make any modifications to the installation process. Once you 
click the next button you cannot do any modifications. 

 

 

16. INSTALLING THE PACKAGES  

First it formats the file systems and copies the files to our hard disk to continue 
installation. Then there starts the installing of packages which may take up to several 
minutes of time during which we need to insert next two CD ROMs to complete the 
installation process. 
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17. CREATING A BOOT DISK 

Here the prompts you to create a Linux boot disk on your choice for your further 
requirement. 

 

18. CONFIGURING YOUR DISPLAY  

At this stage you need to select your video card type and monitor configuration and 
also you restore to the original values. 

19. END OF INSTALLATION PROCESS At the end of the installation process it will 
remove all the media that is used by the installation. And reboots your system again. 

 

After the Installation: 

After the installation your computer will reboot and you will go through a simple 
configuration procedure to get your computer ready for use. It includes such things 
as setting the time, setting the password for the "root" user, and creating other user 
accounts. 
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Click Next: 

 

Click Next: 

 

Click Next: 
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Click Next: 

 

Click Next: 

 

Click Next: 

 

Out-Of-The-Box Experience: 

 

Note: All of the following assumes that you used the defaults during installation of 
Fedora Core. If you picked different defaults then you might not have pieces like 
XMMS (an audio player like Win Amp) already installed and you'll need to add those 
as you go along. It doesn't really hurt anything; it will just add a few extra steps here 
and there. 



DEPARTMENT OF CSE IT WORKSHOP LAB MANUAL  

 

50 

 

Many of the tools you are likely to need for everyday use come with Fedora Core but 
you might not recognize them if you are more familiar with Windows tools. For 
example, Mozilla is the most commonly used browser under Linux. It takes the place 
of Microsoft's Internet Explorer (IE) and in my opinion does a much better job than IE 
does. Here's a quick table listing some common equivalences: 

Internet Explorer Mozilla 

Adobe Photoshop The GIMP 

Adobe Acrobat Reader GPDF 

Win Amp XMMS 

Microsoft Outlook Ximian Evolution 

Microsoft Word Open Office Writer 

Microsoft PowerPoint Open Office 
Impress 

WinZip File Roller 

Notepad gedit 

ICQ/AIM/MSN 
Messenger/Trillian 

Gaim 

Audio grabber Sound Juicer 

 
As time goes by I hope to talk about all of these applications and provide screenshots 
and some basic information for each one, in the meantime though I've singled out 
just a few for further attention. Click on the links to see more information on each 
one. 

Filling In the Gaps: 

As a long time Windows user there are certain pieces of software and certain 
capabilities that I really expect to have. For example, I expect to be able to view and 
interact with the same multimedia elements as my Windows counterparts. Music files 
(.MP3, .WAV, and .OGG), video files in various formats (.WMV, .MPG, .MOV, .RM, 
.AVI), video discs (VCD, SVCD, DVD), etc. are all things you can hardly go three 
clicks on the Internet without stumbling across. I need to be able to view/listen to all 
of them. 
The following software addresses many of those needs and installation of it is really 
really simple. In fact it is easier than installing similar software on Windows usually is. 
To get to that level of ease does take a couple of steps though so you will want to 
read the sections below entitled 

 A Word About Permissions and Software Installation Made Easy eventually to add 
the Apt and Synaptic software to your machine. In the meantime, first read about 
some of the software that Apt and Synaptic can get for you. 

Viva Questions: 

1) Give the advantages of Linux over other OS? 

2) What do you mean by open source OS? 

3) What are the commands used to make disk partitioning manually in Linux 
OS? 

4) What do you mean by dual boot systems? 

http://www.johnmunsch.com/articles/FedoraCoreGettingStarted/programs/gpdf.html
http://www.johnmunsch.com/articles/FedoraCoreGettingStarted/programs/oowriter.html
http://www.johnmunsch.com/articles/FedoraCoreGettingStarted/programs/ooimpress.html
http://www.johnmunsch.com/articles/FedoraCoreGettingStarted/programs/ooimpress.html
http://www.johnmunsch.com/articles/FedoraCoreGettingStarted/programs/gaim.html
http://www.johnmunsch.com/articles/FedoraCoreGettingStarted/#A_Word_About_Permissions#A_Word_About_Permissions
http://www.johnmunsch.com/articles/FedoraCoreGettingStarted/#Software_Installation_Made_Easy#Software_Installation_Made_Easy
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TASK  6: 

AIM:  Exposure to Basic commands in Linux General Purpose utilities like man, who, 
tty, clear, date, cal, passwd; File Handling utilities like pwd, mkdir, rmdir, cp, rm, mv, 
cat, cd, ls, ln; Filters like wc, cmp, diff, head, tail, sort. 

To edit a file-$vi 

i-for insert mode, character  you type will show up as text 

x-for deleting a character 

3x-for deleting  3 consecutive characters 

a-for appending characters 

[esc}-to get into command mode 

u-to undo the most recent change 

U-to undo all the changes made to the line 

p-to put the contents of the recent buffer back to where the cursor is 

press [esc]-wq to write the file to disk and quit 

press [esc]-q! to quit without writing the file to disk 

1 or space bar or right arrow – To move right one character 

h or crtl+h or left arrow-To move left one character 

j or ctrl+j or ctrl+n or down arrow –To move down one line 

k or ctrl+p or up arrow- To move up one line 

0-To move to the top of the line 

$- To move to the end of the current line 

+ or RETURN – To move to the beginning of the next line 

. – To move to the beginning of the previous line 

CTRL+f – move forward one full screen 

Ctrl+d – move forward one half screen 

Ctrl+b – move back one full screen 

Ctrl+u – move back one half screen 

G-move to the end of the file 

R b – replace the current character with b 

3rd-replace 3 characters with b 
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Wild card Matches 

* 0 or more characters 

? Exactly one character 

[abcde] Exactly one character listed 

[a-e] Exactly one character in the given range 

[!abcde] Any character that is not listed 

[!a-e] Any character that is not in the given 
range 

{debian,linux} Exactly one entire word in the options 
given 

s.no Command name description example 

1 Date Display or set the 
he linux system 
time  

$date 

2 Ls Viewing linux file 
system 

$ls 

3 Tree Show the root or 
base directory lay 
out,along sub 
directories 

$tree 

4 Man Display the manual 
pages 

$man 

5 Cat Outputs contents of 
file name to display 

$cat 

6 Mv Moves specific 
files/directories to 
specific 
files/directories 

$mv file(s)/dir(s) 
files(s)?dir(s) 

7 Cp Copies one file and 
creates another file 

$cp file 1 file 2 

8 Rm Deletes file $rm file 

9 Grep Searching through 
file and displays 
lines containing 
matching string 

$grey string files(s) 

10 Mkdir Creates an empty 
directory 

$mkdir dirname  
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11 Rmdir Deletes directory(if 
empty) 

$rm dir dirname 

12 Ps Displays quick list 
of  process 

$ps 

13 Pwd Displays the path of 
current directory 

$pwd 

14 Clear Clears all textand 
leave you with the 
and promt at the 
top of the window 

$clear 

15 Head Display the first few 

Lines of a file 

$head-line count 
file name 

16 Tail Display the last few 
lines of a file 

$tail-line count file 
name 

17 Wc Count number of 
lines/words 
/characters in a file 

$wc file name 

18 Who List users currently 
loggedin 

$who 
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Week 4: 
 
Task 7: Practice hardware troubleshooting exercises related to various components 
of computer like monitor, drives, memory devices, printers etc. and software 
troubleshooting related to BIOS etc 
 
AIM: Hardware troubleshooting 

Troubleshoot:- 

1. If you hit the power button & nothing happened. 

 Check all power connections. 

 Check for power on mother board.   

2. If the system turns on but does not beep or begin to boot up. 

 Remove all components except motherboard/ cpu / mother 
check by giving power to them  

     Computer error beeps codes: 

No beep: short, no power, bad CPU/ MD, loose peripherals.One 
beep: everything is normal & computer posted tax.Two beeps: 
post / CMOS error.One long beep One short beep: Motherboard 
problem.One long beep two short beep: video problem.One 
long beep 3 short beeps: video problem.3 long beeps: keyboard 
error.Repeated long beep:  memory error.Continuous high- low 
beeps: CPU overheating  

Basic troubleshooting: 

Sometimes things do not work exactly as planned at this point. Sometimes the 
system will not power on at all. Sometimes it will power on, but you get no video. 
Sometimes you will get beep codes. Sometimes you hear the fans, but the rest of the 
PC just sits there and does nothing. If things didn't go according to plan, troubleshoot 
the system. Walk mentally through the boot process and check all hardware as it 
goes. Think like the computer thinks, if you know what I mean. Here is a list of some 
of the more common problems.  

1. The power does not even turn on. This sometimes happens on ATX 
machines and it usually tracks down to the fact that the power switch is not 
properly connected to the motherboard or it is not connected at all. Find the 
power switch lead and make sure it is connected to the motherboard. It’s a 
possibility that simply reversing the lead will do the trick. If this is the not the 
case, then make sure the motherboard is not grounded somehow. Make sure 
that the board is not touching the case (this is what the spacers are for). Make 
sure that none of the screws that hold the board in place is touching anything 
metal or any of the electrical pathways on the motherboard. If you have any 
doubt on this, you can remove each screw one at a time and place a washer 
on them. You do not need to remove the motherboard to do this.  

2. The PC boots, but it is giving beep codes. This is actually better than having 
to track everything down on your own, because at least the PC is giving you a 
hint as to what is wrong. You can also use the PC Mechanic Beep Codes E-
book available on the PC Mechanic CD to track it down for other BIOS 
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versions. Often, these beep codes will not tell you exactly what the problem 
is, but will point you at the trouble device. This information will then get you 
pointed in the correct direction. 

3. The fans come on, but you get no video or beeps. Sometimes, this is because 
some key component may not be plugged in well or may not be operational. 
Check the memory modules and the processor to be sure they are firmly 
installed. You might want to make sure the processor is actually working. One 
way that I have used to see if a processor is working is to remove or unplug 
the CPU fan and place your fingers on the CPU to see if it heats up real fast. 
If it does, its OK and don’t let it run this way for long. If it remains at room 
temperature for awhile, then there is no juice going through the processor and 
it may need replacing. The keyboard doesn’t seem to work. This one doesn’t 
happen too often, but if it does, your two trouble sources will be the keyboard 
itself or the keyboard controller on the motherboard. Hope it isn’t the second 
one. 

 Software troubleshooting 

Error messages encountered during boot before Windows loads 

Ensure that your computer BIOS settings are correctly configured to the hardware 
that is installed in your computer 

Error messages while windows loading 

1.If you have recently installed or changed something that could have caused normal 
windows to stop loading , try loading the last known good configuration 

2.If you are unable to get into Normal windows and believe that removing or 
uninstalling a program or changing a setting may help enable you to get into windows 
, boot the computer into windows XP safe mode 

3.If your computer has worked fine in the past but recently   has been experiencing 
the issue you are encountering run the system restore option to restore the computer 
to an earlier date 

Other error messages that occur while windows is loading or after windows is 
loaded 

1.If error occur but windows still loads , verify no issues or conflict exits in device 
manager  

2.Ensure that if programs are loading automatically that these errors are not 
associated with these programs 

3.Make sure Windows XP is up to date by checking Microsoft windows update page 

4.If your computer has virus protection installed make sure that it is up to date and 
that no virus are being detected 

5. If your computer has worked fine in the past but recently   has been experiencing 
the issue you are encountering run the system restore option to restore the computer 
to an earlier date 

Software Troubleshooting: 
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BIOS SETUP & DISK FORMATTING  

What Is BIOS?  BIOS is an acronym for Basic Input Output System.  

Why BIOS?  

To run any system, there must be default settings so that the system can load those 
settings when it is started or restarted. For a computer system the basic I/O settings 
and boot process details are necessary to start a system.  

All these default, predefined settings will be loaded in the BIOS and whenever we 
start the system, these settings will be loaded.  

How to view BIOS?  
Whenever we start the system, we can enter into the BIOS Setup Utility by pressing 
Del Key. Sometimes an F1 or F8 key has to be instead of DEL key, depending on the 
type of BIOS.  
When we enter in to this utility we get these following menus/services, depending 
upon our mother board.  
In main Menu, we can view the details such as BIOS Version, Processor Type, and 
Speed, RAM Size and the system bus speed and memory speed.  
We can change the settings like language system time and date. We can even 
change the hyper threading facility if the processor supports this technology.  
We must be very careful when we change these settings otherwise it may cause our 
system to malfunction. Here, we can change the settings of PCI devices, Floppy 
Drives configuration and chipset, USB peripheral devices and even monitoring the 
Hardware.  
Security  
We can set the supervisor password, to restrict unauthorized users to enter the BIOS 
setup utility. User password can also be set to restrict the unauthorized persons to 
boot or use the system.  
How to type a Password?  
      We can even set the Chassis Intrusion to protect the system devices from 
removing the components of the system.  
Power  
     The power settings protect the system from power failures by configuring the 
ACPI.  
For example, after power failure we can stay off the system or Power on the system 
or else we can even make the system to restore its previous state by selecting the 
appropriate options.  
Boot  
Silent boot : If this option is enabled it displays only the OEM logo and in the 
background POST(Power on Self Test) completes. If this is disabled, instead of 
LOGO, we can view POST messages  
Rapid BIOS Boot: By enabling this option it will decrease the time needed to boot the 
by skipping some unnecessary tests.  
Here, we can also set the boot sequence from the available devices by selecting 
Boot Device Priority.  
We can even view the Hard Drives and any removable devices and attached to the 
system.  
Exit  
By selecting the appropriate options we can exit from the BIOS setup like exiting the 
setup by saving or discarding the changes or even by loading optimal or default 
values.  
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Week 5:  
Task 8: NETWORKING  
Orientation & Connectivity Boot Camp:  Students should get connected to their 
Local Area Network and access the Internet. In the process they configure the 
TCP/IP setting. Finally students should demonstrate, to the instructor, how to 
access the websites and email. If there is no internet connectivity preparations 
need to be made by the instructors to simulate the WWW on the LAN 

PURPOSE: To learn Local Area Network and access the Internet. In the process 
they configure the TCP/IP setting. Finally students should demonstrate, to the 
instructor, how to access the websites and email  

THEORY: 

The internet is a world wide, publicly network of interconnected computer networks  

LOCAL AREA NETWORK: 

LANs are privately owned networks with in a single building or campus of up to few 
kilometers in size. 

WIDE AREA NETWORK: 

A WAN is a network that connects computers across a large geographic area such 
as a city or country 

TCP/IP (Transmission Control Protocol/Internet Protocol): 

Collection of methods used to connect servers on the internet and to exchange data. 

HTML (Hyper Text Markup Language): 

The coding used to control the look of documents on the web 

HTTP (Hyper Text Transfer Protocol): 

Part of a URL that identifies the location as one that uses HTML 

IP(Internet Protocol): 

A format for contents and addresses of packets of information sent over the internet 

IP ADDRESS: 

An identifier for a computer or device on a TCP/IP network  

SEARCH ENGINE: 

A program that searches documents located on the Internet for keywords or phrases 
entered by a person browsing the net. 

Internet Connection requirements: 

 TCP/IP protocol 

 Client Software 
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 ISP Account 

Means of communication to the net 

 telephone Modem 

 Ethernet 

 ISDN(Integrated Services Digital Network) 

 DSL(Digital Subscriber Line) 

 Satellite. 

PROCEDURE: 

1. Go to startcontrol Panel open Network Connections Click  
create a new connection and then click next The  
new connection wizard window opens , click next  
to continue Choose one of the options in the next 
dialog box .Choose one of the three options in the 
next dialog box  

 If you do not have an internet account  

click choose from a list of ISPs  and then  click next If 
you have an account click  Set up my connection 
manually.If you have a CD from the ISP click use the 
CD I got from an ISP and then click next 

2. Follow the next steps ad per the option you selected. 
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Week 6: Internet & World Web  
Task 9: Orientation & Connectivity Boot Camp and surfing the Web using Web 
Browsers 

Web Browsers, Surfing the Web: Students customize their web browsers with 
the LAN proxy settings, bookmarks, search toolbars and pop up blockers. 
Also, plug-ins like Macromedia Flash and JRE for applets should be configured 

PURPOSE: To learn to surf the web 

THEORY: 

 Web browser provides the means to the searching and also helps to 
download the web content. 

 Web browsers support most of the famous Internet Protocols like HTTP, FTP.  

 Common file formats a browser accepts  are HTML  

 Well known browsers natively support a variety of other formats in addition to 
HTML such as JPEG,PNG,GIF image formats 

 Different web browsers available in the market are: 

 Silversmith ,Mosaic ,Netscape,Mozilla,Opera,Lynx,Safari 

 

Bookmark: 

Each web browser is built-in with the support of Internet Bookmarks which serve as a 
named anchor – primarily to URLs. The primary Purpose of this book mark is to 
easily catalog and access web pages that the web browser user has visited or plans 
to visit, without having to navigate the web to get there. 

Pop-up Blockers: 

Pop-ups are a form of online advertising on the WWW intended to attract the 
attention of the users. These pop ups are hosted on the web sites which are 
frequently visited by the netizens. These pop ups are activated when these web sites 
open a new web browser window and there by displaying the advertisements. 

Plug-ins: 

A plug-in is a software component program that interacts with a main application to 
provide a better integration of the media. The basic difference between application 
programs and plug-ins is that multimedia files are launched in a separate window 
where as in plug-ins multimedia play in the browser window. 

Few famous plug-INS are: 

 Apple Quick Time 

 Macromedia flash 

 Microsoft Media Player 
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 Adobe Shockwave 

 Sun Microsystems Java Applet 

PROCEDURE: LAN Proxy Settings: 

 Select  tools menu in  Internet Explorer,Select Internet Options 

 

 Select  connections 

 

 You end up in two options 

 Dial-up  and virtual network settings 

 LAN setting 
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The LAN connection Settings are as follows: 

 

Select the properties button. The properties of the ipaddress, default 
Gateway and the DNS server details are reflected in the dialog box. 

 

 The selection at this step is dependent on the kind of connection you 
are trying to configure. They are: 

 Dial-up modem connection 

 LAN connection 

 DSL or Cable modem 
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Week 8: 
TASK 10: 

Search Engines & Netiquette:  

PURPOSE: To know what search engines are and how to use the search engines. 

THEORY:  Search engine: 

A search engine can be defined as a web site with tools which help you to find 
information on the internet 

Function of a search engine: 

 You can find anything from a schedule of White house tours to instructions for 
removing stains from clothes. 

Limitations: 

 Search engines visit web sites only several weeks. Search engines cannot see 
information in other data bases later on. 

On the internet a search engine is a coordinated set of programs that includes: A 
spider (crawler or bot) that goes to every page or representative pages on every web 
site that wants to be searchable and reads it, using hypertext links on each page to 
discover and read site’s other pages.  

Pros:  

 You can select the search terms 
 You can use the same search terms with multiple search engines 
 You can change search terms as much as you wish 
 You will normally receive numerous links 
 Its fast 

Cons:     There are so many different search engines it may be difficult to choose 
 You will normally receive too many links often making it difficult to 

identify the most relevant sites. 
 The vast majority of links may be only marginally relevant or 

altogether irrelevant 
EX: 

 Alta Vista,Ask Jeeves,Google,Lycos etc., 
Meta Search Engines: 
 Meta search engines or “metacrawlers” don’t crawl the web themselves. Instead 
they search the resources of multiple search engines by sending a search to several 
search engines at once aggregating the result. 
Pros: 

 You only need to use one search tool which is time- efficient 
 You only need to learn how to use one search engine reducing 

learning curve 
 You benefit from the difference among several search tools at once 

Cons: 

 Meta search services may not be able to leverage each individual 
search engines full range of query tools resulting in less refined 
searches 

 You can not personally select the search engines queried by Meta 
search services. 
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Week 8:  
Task 11: Cyber Hygiene (Demonstration):  
PURPOSE: To learn various threats on the internet and configure the computer to be 
safe on the internet. 
 
THEORY: 
Antivirus: 
Antivirus software is a program that either comes installed on your computer or that 
you purchase and install yourself. It protects your computer against most viruses, 
worms, Trojan horses and other unwanted invaders that can make your computer 
sick. 
Firewall: 
A firewall is a special software or hardware designed to protect a private computer 
network from unauthorized access. A firewall is a set of related programs located at a 
network gateway server which protects the resources of the private network from 
users from other networks. 
 
PROCEDURE:Installing Symantec antivirus for Windows: 

 Insert  Symantec antivirus CD into your CD drive 

 Double click  on the Symantec-setup.exe 

 The installer will open  

 Click next to proceed 

 License agreement will open. Click I accept the terms of the license 
agreement and then click next. 

 Follow the instruction on the screen to complete the installation. 

Get Computer Updates: 

 Click start settingscontrol panel, 

 Click Automatic Updates icon to open Automatic Updates dialog box 

 Check the box Keep my computer up to date  

 Choose a setting 

 Click OK 

Block Pop ups: 

 In the Internet explorer open  toolspop-up blocker 

 Click on Turn on Pop- up blocker 

Windows Firewall: 

 Goto Startcontrol panelNetwork and Internet 
Connectionswindows firewall 

 In the general tab check the On(recommended) box 
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 If you don’t want any exceptions check on  Don’t allow exceptions 
box 

 

PURPOSE:  Test to simulate all the tasks related to Internet Security 

THEORY: 

 Identify and explain the components  required to establish a network 

 Establish internet connection and create a new email id , send mail and 
attachment file to other mail account 

 Define search engine. List the various search engines. Navigate through any 
of the search engine like Google and explore its features. 

 Download a file from the internet. Write the various steps involved in 
downloading 

 What is Antivirus software? List a few popular anti virus kits available. 

 Explain the functionality of the firewall quoting a few examples 
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Week 9: 
TASK 12: 
 

To create project certificate, Features to be covered:-Formatting Fonts in word, 
Drop Cap in word, Applying Text effects, Using Character Spacing, Borders 
and Colors, Inserting Header and Footer, Using Date and Time option in both 
LaTeX and Word. 
PURPOSE: To create a document applying the above mentioned techniques. 

THEORY:   

LaTeX: 
     In the late 1970’s Donald Knuth introduced TEX. In the 1980’s Leslie  
Lamport decided TEX was too hard (other than Knuth) and introduced  

LaTeX.TEX comes from Greek letter which is short for the word “technical” or  
“technique”. LaTeX is pronounced as “La tek” or “Lay tek”.LaTeX is a typesetting 
program and is an extension of the original program TEX written by Donald Knuth. 

Advantages: 
1)It is easy to read and compile 
Disadvantages: 
1)Not widely used like any other MS office product. 

2)Like MS office product it is not  

  CREATE A FILE:  Type the code in a text editor like Latex Editor or notepad and 

save the file with an extension of “tex” for example “ examplefilename.tex ” 

2)The first line should be “ \ documentclass{article} tells LaTeX that what we  want 

to produce is an article. If we want to write a book then we will  write the above line 

as “ \ documentclass{book}”. 

3)The whole document we want to typeset should be included between 

“\begin{document}” and “ \end{document}”. 

\documentclass{article} 

\begin{document} 

This is my \emph{first} document prepared in \LaTeX. 
\end{document} 
In our example the first three words are produced as typed. Then “\emph{first}”, 
becomes first in the output i.e. “\emph” is a command to display the text in 

emphasized format (italic letters). Again , the next three words come out without any 

change in the output. But the input \LaTeX comes out in the output as LATEX. 
Header and Footer: 

1. To create a header, enter text or graphics in the header area or click 
button on the header and footer tool bar. 

                    2. To create footer, click switch between header and footer. 

                    3. Then click exit. 
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       Date and Time: 
Insert a date field that automatically updates so that the current date is 

displayed when you open or print the file. 
Insert a time field that automatically updates so that the current time is 

displayed when you open or print the file. 
        Border: 

 
On the format menu, click borders and shadings. 
To specify that the border appears on a particular side of a page, such as 

only at the top, click custom under setting. 
To specify a particular page or section for the borders to appear, click the 

option you want to apply. 
To specify the exact position of the border on the page. 
Finally, click OK. 

  Color: 
Select the text you want to make a different color. 

To apply the color most recently applied to text, click font color. 

To apply different colors, click the arrow on the right of the font color button, 
select the color you want and then click the button. 

Procedure: 

 First click start button on the status bar.  

Then select program and again select Microsoft word. On the menu bar click 

the file option.  

Then again click new. Then enter the text not less than 100 words. 

A header appears at the top and the footer appears at the bottom of each             

page. 

 On the view menu, click header and footer option. From dialogue box, make 

the required changes and then click OK.  

On the format menu, click borders and shading s make required changes and 

the click OK.  

Select the text you want and make the different color. Click on right of the font 

color button,  

Then select the color you want and then click on the button. 
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Week  10: 
TASK 13:  

Formatting Styles, Inserting table, Bullets and Numbering, Changing Text 
Direction, Cell alignment, Footnote, Hyperlink, Symbols, Spell Check and  
Track Changes. 

PURPOSE: To create a document applying the above mentioned techniques. 

THEORY:      Table: 

 

   A table consists of rows and columns. 

      Cell Alignment: 

 

  Aligns contents written in a table in the top left corner or top right 
corner or in the center etc... 

     Foot Note: 

Foot notes are used to comments on, or provide references for text in a document. 

    Hyperlink: 
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  It is a colored and underlined text or a graphic that you click to go to a 
file, a location in a file, an HTML page on the World Wide Web, or an HTML page in 
an intranet. 

Symbols: 

 

  You may not be able to enter certain symbols into your word 
document, as there is a limitation on the keys on the key board. Creating these new 
symbols especially when working with mathematical terms it becomes very difficult 
.For example we can insert symbols such as,,, ..  

Spell check: 

 

  It automatically checks for spelling and grammatical errors 

Bullets and Numbering: 

 

  In Microsoft word we can easily create bulleted or numbered list of 
items. 
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FormattingStyles:  

 

  A style is a set of rules to be followed for the effective document. Style 
can be applied to text, paragraph, table or a list. 

Changing text direction: 

 

You can change the text orientation in drawing objects, such as text 
boxes, shapes, and callouts, or in table cells so that the text is displayed 
vertically or horizontally. 

Track changes: 

  Track changes are an excellent feature of Microsoft word as it enables 
a user or reviewer to keep track of the changes that have taken a period. Changes 
like insertion, deletion or formatting changes can be kept track of. 

Procedure: 

Changing Text direction: 

1. Click the drawing object or table cell that contains the text you want to 
change.  

2. On the Format menu, click Text Direction.  

3. Click the orientation you want. 

Table:  

 

 

 

 

 

1. Click where you want to create a table. 



DEPARTMENT OF CSE IT WORKSHOP LAB MANUAL  

 

70 

 

2. On the Table menu, point to Insert, and then click Table. 

3. Under Table size, select the number of columns and rows. 

4. Under AutoFit behavior, choose options to adjust table size. 

5. To use a built-in table format, click AutoFormat. 

Select the options you want 

Cell Alignment: 

 

1. Click the cell that contains text you want to align.  

2. On the Tables and Borders toolbar, select the option for the horizontal and 
vertical alignment you want— for example, Align Bottom Center or Align Top 
Right.  

Foot Note: 

1. In print layout view, click where you want to insert the note reference mark.  

2. On the Insert menu, point to Reference, and then click Footnote.  

3. Click Footnotes or Endnotes.  

By default, Word places footnotes at the end of each page and endnotes at 
the end of the document. You can change the placement of footnotes and 
endnotes by making a selection in the Footnotes or Endnotes box. 

4. In the Number format box, click the format you want.  

5. Click Insert. Word inserts the note number and places the insertion point next 
to the note number. Type the note text.  

6. Scroll to your place in the document and continue typing.  

As you insert additional footnotes or endnotes in the document, Word 
automatically applies the correct number format. 

Hyper link:  

 



DEPARTMENT OF CSE IT WORKSHOP LAB MANUAL  

 

71 

 

Select the text or picture you want to display as the hyperlink, and then click Insert 

Hyperlink on the Standard toolbar 

Do one of the following:  

1. Link to an existing file or web page: 

1. Under Link to, click Existing File or Web Page. 

2. In the Address box, type the address you want to link to or, in the Look 

in box, click the down arrow, and navigate to and select the file. 

2. Link to a file you haven’t created yet 

Under Link to, click Create New Document. 

3. In the Name of new document box, type the name of the new file.  

4. Under When to edit, click either Edit the new document later or Edit 

the new document now 

An e-mail address: 

1. Select the text or picture you want to display as the hyperlink, and then click 

Insert Hyperlink on the Standard toolbar 

2. Under Link to, click E-mail Address. 

3. Either type the e-mail address you want in the E-mail address box, or select 

an e-mail address in the recently used e-mail addresses box.  

4. In the Subject box, type the subject of the e-mail message 

A specific location in another document  

1. Insert a bookmark in the destination file or Web page.  

2. Open the file that you want to link from, and select the text or object you want 

to display as the hyperlink. On the Standard toolbar, click Insert Hyperlink.  

3. Under Link to, click Existing File or Web Page.  

4. In the Look in box, click the down arrow, and navigate to and select the file 

that you want to link to.  

5. Click Bookmark, select the bookmark you want, and then click OK. 

Symbol: 

 
 

1. Click where you want to insert the symbol.  

2. On the Insert menu, click Symbol, and then click the Symbols tab.  
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3. In the Font box, click the font that you want.  

4. Double-click the symbol that you want to insert.  

5. Click Close 

Spell check: 

On the Standard toolbar, click Spelling and Grammar .  
1. When Word finds a possible spelling or grammatical problem, make your 

changes in the Spelling and Grammar dialog box.  

Bullets and Numbering: 

 

1. Type 1. to start a numbered list or * (asterisk) to start a bulleted list, and then 
press SPACEBAR or TAB. 

2. Type any text you want. 

3. Press ENTER to add the next list item. 

Word automatically inserts the next number or bullet. 

4. To finish the list, press ENTER twice, or press BACKSPACE to delete the last 
bullet or number in the list 

Formatting Styles: 

1. Select the words, paragraph, list, or table you want to change.  

2. If the Styles and Formatting task pane  is not open, click Styles and 
Formatting on the Formatting toolbar 

3. Click the style you want in the Styles and Formatting task pane. 

If the style you want is not listed, click All Styles in the Show box 

Track Changes: 

1. Open the document you want to revise.  

2. On the Tools menu, click Track Changes 
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Week 11:  
Task 14:  Word Orientation 
Create a Newsletter. Features to be covered:-Table of content. Newspaper 
columns,  Images from files and clipart, Drawing toolbar and Word Art, 
Formatting Images, Textboxes and Paragraphs. 
PURPOSE:  To create a news Letter  

THEORY:  Table of contents: 

  Table of contents displays a list of headings in a created document. It 
basically provides an outline of the entire document created 

 Newspaper columns: 

 

  One can create a newspaper columns document by specifying the 
number of new letter-style column required and then adjust their width, and add 
vertical lines between columns. 

Images from files and clipart: 

 

  Inserting a picture (graphic) from a file and clipart may be required for 
a document. This picture could be a scanned photograph or any other digitally 
produced one. These pictures can be modified, resized, cropped and enhanced. 

Drawing toolbar and Word Art: 
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  One can create his/her own drawings in Microsoft word.Ms word 
provides a full fledged drawing tool bar. 

  Word Art in Microsoft word enables you to create special and 
decorative text. 

Formatting Images, Textboxes and Paragraphs: 

 

  Formatting an image includes selecting appropriate color, size, layout 
and cropping. 

  Generally the text in a document follows a standard orientation (line 
after line). A text box provides a different orientation to the text with in a document. It 
can arrange the text in any where and can be resized and moreover moved to any 
section of the document or even outside. 

  When you are formatting a paragraph, you do not need to highlight the 
entire paragraph. Placing the cursor any where in the paragraph enables you to 
format it. After you set a paragraph format, subsequent paragraphs will have the 
same format unless you change the format 

PROCEDURE: 

Table of contents: 
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1. Click where you want to insert the table of contents.  

2. On the Insert menu, point to Reference, and click Index and Tables.  

3. Click the Table of Contents tab.  

4. To use one of the available designs, click a design in the Formats box.  

5. Select any other table of contents options you want.  

Newspaper columns: 

1. Select the entire or part of document to be converted into a newsletter-style 

2. Click on format menu, select columns 

3. Any desired number of columns are presets-one or two or three or left or right 
b\can be selected. 

4. Width and spacing can be fixed and equal columns width can be checked for 
uniformity 

5. If newspaper columns are to be separated by a line, then check line between 

6. Under apply to will be whole document if entire document is selected else we have 
to select a selected text. 

7. Click ok 

Inserting images from files and clip art: 

1. Click where you want to insert the picture.  

2. On the Insert menu, point to Picture, and then click From File.  

3. Locate the picture you want to insert.  

4. Double-click the picture you want to insert.  

CLIP ART: 

1. On the Insert menu, point to Picture, and then click Clip Art.  

2. In the Clip Art task pane, in the Search for box, type a word or phrase 
that describes the clip you want or type in all or some of the file name 
of the clip.  

3. To narrow your search, do one or both of the following:  

 To limit search results to a specific collection of clips, in the 
Search in box, click the arrow and select the collections you 
want to search.  

 To limit search results to a specific type of media file, in the 
Results should be box, click the arrow and select the check 
box next to the types of clips you want to find.  

4. Click Go.  
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5. If you don't know the exact file name, you can substitute wildcard 
characters for one or more real characters. Use the asterisk (*) as a substitute 
for zero or more characters in a file name. Use the question mark (?) as a 
substitute for a single character in a file name. 

6. In the Results box, click the clip to insert it.  

Drawing Toolbar and Word Art: 

1. Click in your document where you want to create the drawing.  

2. On the Insert menu, point to Picture, and then click New Drawing.  

A drawing canvas is inserted into your document. 

3. Use the Drawing toolbar to add any shapes or pictures that you want.  

WORD ART: 

 

1. On the Drawing toolbar, click Insert WordArt .  

2. Click the WordArt effect you want, and then click OK.  

3. In the Edit WordArt Text dialog box, type the text you want. 

4. Do any of the following:  

 To change the font type, in the Font list, select a font.  

 To change the font size, in the Size list, select a size.  

 To make text bold, click the Bold button.  

 To make text italic, click the Italic button.  

Formatting Images: 

1. Formatting of the images can be achieved by selecting the image and double click 

on the picture, format picture dialog box appears. 

2. The same can be achieved by selecting the tools menu  customizetool bars 

tabpicture and click close. 

Basic formatting features of an image 

Resize a drawing 

1. Select the drawing canvas 

2. On the Drawing Canvas toolbar, do one of the following: 
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o To make the drawing canvas boundary larger without changing the size of 

the objects on the canvas, click Expand. 

o To make the drawing canvas boundary fit tightly around the drawing 

objects or pictures, click Fit. 

o To scale the drawing and make the objects and canvas proportionately 

smaller or larger, click Scale Drawing, and then drag the edges of the 

canvas. 

Resize a picture or shape 

1. Position the mouse pointer over one of the sizing handles  

2. Drag the sizing handle until the object is the shape and size you want.  

To increase or decrease the size in one or more directions, drag the mouse 

away from or toward the center, while doing one of the following:  

o To keep the center of an object in the same place, hold down CTRL 

while dragging the mouse.  

o To maintain the object's proportions, drag one of the corner sizing 

handles.  

o To maintain the proportions while keeping the center in the same 

place, hold down CTRL while dragging one of the corner sizing 

handles. 

Crop a picture  

 

1. Select the picture you want to crop.  

2. On the Picture toolbar, click Crop.  

3. Position the cropping tool over a cropping handle and then do one of the 

following:  

o To crop one side, drag the center handle on that side inward.  

o To crop equally on two sides at once, hold down CTRL as you drag 

the center handle on either side inward.  

o To crop equally on all four sides at once, hold down CTRL as you drag 

a corner handle inward.  

4. On the Picture toolbar, click Crop to turn off the Crop command. 

Text Box:   

On the Drawing toolbar, click Text Box .  

1. Click or drag in your document where you want to insert the text box 
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2. You can use the options on the Drawing toolbar to enhance a text box— for 

example, to change the fill color— just as you can with any other drawing 

object 

Paragraphs: 

 

Change line spacing  

Select the text you want to change. 

1. On the Formatting toolbar, point to Line Spacing, and then do one of the 

following:  

o To apply a new setting, click the arrow, and then select the number 

that you want.  

o To apply the most recently used setting, click the button.  

o To set more precise measurements, click the arrow, click More, and 

then select the options you want under Line Spacing.  

Change spacing before or after paragraphs 

1. Select the paragraphs in which you want to change spacing.  

2. On the Format menu->click Paragraph->and then click the Indents and 

Spacing tab.  

3. Under Spacing, enter the spacing you want in the Before or After box.  

Change paragraph direction 

1. Place the insertion point in the paragraph that you want to change, or select 

several paragraphs.  

2. Do one of the following:  

o To have text begin from the left, click Left-to-Right on the Formatting 

toolbar.  

o To have text begin from the right, click Right-to-Left on the Formatting 

toolbar.  

When you change the paragraph direction, Microsoft Word leaves justified and 
centered text as it is. In the case of left-aligned or right-aligned text, Word flips the 
alignment to its opposite. For example, if you have a left-to-right paragraph that is 
right aligned, such as the date at the top of a letter, clicking Right-to-Left results in a 
right-to-left paragraph that is left aligned. 
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Week 12:  
Task 15: Using LaTeX/Word:  Creating a Feed Back Form:-Features to be 
covered: Forms, Text Fields, Inserting objects and Mail Merge in Word. 

PURPOSE: To create a Feed Back form, text fields, inserting objects, mail merging, 

THEORY: 

Forms: 

 Using Microsoft word one can create an organized and structured document 
with a provision to enter the required information into it. A document of such nature is 
called a form. 

Mail Merge: 

 

 It helps us to produce from letters mailing labels envelopes catalogs and 
others types of merged document. It is so found in the tools option on the menu bar. 
In tools we have letters and mailing. In letters and mailing we have mail merge mail 
merge tool box envelopes tables and letters wizard. In mail merge select the required 
document you are working on. A window for customizing the data base structure 
appears. This file contains the names, address details with contact numbers etc of 
people you wish to send the letters. 

Inserting objects: 

 Insert an object such as drawing word art text effects or an equation at the 
inserting point. 
Fields: 
 It inserts a field at the inserting font fields are used to insert a variety of 
information automatically. Select table in table select insert. In that select insert table 
a box containing number of rows and columns will appear. Select six colors and four 
rows and click o.k. Given the first row as date, problem repeated student’s signature 
action recommended problem status and councilors sign. Insert the objects in the 
feed back form and apply the text fields in the  form. 
PROCEDURE: 

Mail Merge: 

1. Open a document and type the complete body of the letter and format it 
as required. 
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2. Create a data source and choose mail merge from tool bar a window is 
displayed. 

3. Click on create button and choose from letter options. Then a window is 
displayed. 

4.  Click active window choose currently active document. Click on data and 
create data source option. 

5. A window for customizing the data base structure appears and this file 
contains the names address details with contact number etc. we can add 
or remove fields from this file. 

6. Once the list of fields is finalized a window of same is displayed and types 
the required file names and click on save button. 

7. A window is displayed. Type the details of 10 candidates. After typing 
details of one person, click on add menu. 

8. Click on the o.k. to finish entering the records mail merge tool bar is 
displayed. 

9. Place the curser at the place where you wish to insert names and click on 
insert mail merge button. A drop list is displayed all fields created would be 
shown. 

10. By highlighting to desired file and click on it we can insert the field into the 
main document and go to begin the mail merge click on mail merge. 

          11. A window is displayed click once on the merge button to generate letters 
for all records in your data source file. 

Forms: 

1. Design the form by sketching a layout first, or use an existing form template 
as a guide. Tables, text boxes, borders, and shading are all design elements 
that can help you create a well-designed form that's easy to use. 

2. On the Standard toolbar, click New Blank Document .  
3. Add the text or graphics you want. For example, enter the questions you want 

answered, and list the available choices.  
4. To insert a text box where users can enter their responses, click the 

document, and then click Text Form Field on the Forms toolbar. If you need 
more space, you can insert multiple text boxes side by side.  To insert check 
boxes that list choices, such as Yes and No, click the document, and then 
click Check Box Form Field on the Forms toolbar. 

5. Save the form.  
Insert line numbers: 

1. On the File menu, click Page Setup, and then click the Layout tab.  

2. In the Apply to box, click Whole document.  

3. Click Line Numbers.  

4. Select the Add line numbering check box, and then select the options you 
want. 
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Week 13: 

Task 16: Creating a Scheduler 

Creating a Scheduler:-Features to be covered: - Gridlines, Format Cells, 
Summation, auto fill, Formatting Text 

PURPOSE: 

To maintain a shift schedule with specifications 

 THEORY: 

  Grid lines: 

 

1. Click the worksheet. 

2. On the file menu, click page setup and the click the sheet tab. 

3. Click gridlines. 

4. Select the sheets on which you want to change the gridlines color. 

5. On the Tools menu click options click the color you want in the color box. 

6. To use the default gridlines color click automatic. 

7. Lines you can add to a chart that make it easier to view and evaluate data. 
Gridlines extend from the tick marks on an axis across a plot area. 

 Format Cell:           
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1. Change the font and font size. 

2. Change the text color. 

3. Make selected text or numbers bold, italic or underlined. 

4. Create a new style. 

Auto fit: 

 

1. Combine cells horizontally or vertically to make one large cell. 

2. Add borders to cells. 

3. Shade cells with colors. 

4. Change the column width and row height 

5. Change the font, font size or colors of text. 

6. Align text vertically at the top, center and bottom of cell. 

  Formatting the text: 
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1. Select the text you want to format. 

2. On the format menu click cells and then click number tab. 

3. In the catalog box click text. 

4. Enter the numbers in the formatted cells. 

5. Click ok. 

6. Then press enter and reenter the data. 

PROCEDURE: 

 First click start button of the screen on status bar. Click on programs and then 
Microsoft excel. To get a new blank work sheet go to programs and then click on 
excel sheet. On the file menu click page setup and then click sheet tab click gridlines. 
In this way do the required changes using format cell, make the required changes 
using formatting text also make the required changes. Enter the data in the data in 
the worksheet consisting of week name person name and timings 7 a.m. to 3 p.m. 
Make all the above changes to the text. 

Viva Questions: 

1) What do you mean by a spread sheet? 

2) What are the contents of a spread sheet? 

3) Describe different types of toolbars available in ms-excel 

4) How can you calculate simple formulas in excel? 

5) How can you navigate the spread sheet? 
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Week 14:  
Task 17 : Calculating GPA 

Calculating GPA-Features to be covered-Cell Referencing, Formulae in excel – 
average, std. deviation, Charts, Renaming and Inserting worksheets, Hyper 
linking, Count Function, HLOOKUP/VLOOKUP 

PURPOSE: 

To maintain a control chart for printing books with given data. 

THEORY: 

1. On the chart menu click chart type 

2. Text direction. 

Click the arrow down next to the text direction button. For right to left click right 
to left. For left to right reading order, click left to right.  

For reading order that is consistent with the language of the first entered 
character, click context. For reading order that is inconsistent with the language 
of the first entered character, click control. 

     3. In the tools menu click options and then click chart tab. 

     4. To show all worksheet data in the chart even if some rows and columns are 
hidden, clear the plot visible cells by check box. 

5. To prevent hidden rows and columns from displaying in the chart, select the 
plot cells only check box. 

Hyper Linking: 

 

1. Create a worksheet: On the file menu, click new, and then click blank 
workbook task pane. 

2. Insert a worksheet: C lick worksheet on the insert menu. Right click on 
sheet tab and then click insert double click the template for the type of sheet 
you want. 

3. Hyperlink:  Using hyperlink we can insert one more sheet in the present 
sheet 

4. Count function:  Create a blank worksheet press control +c. In the 
worksheet select cell A and press control +c. On the tools menu point to 
formula auditing and then click formula auditing menu. 

 

Worksheet: 

 

1. In the file menu go to menu then a new worksheet is created. 
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                     2 To add a single worksheet, click worksheet on the Insert menu. To 
add multiple worksheets hold down shift and then click the number of worksheet 
tasks to add in a open workbook 

Sort:  

1. Click a cell in the list you want to sort. 

2. On the Data menu click sort. 

3.  Under first key sort click the custom sort order you want and then click ok. 

4. Click any other sorting option you want. 

PROCEDURE: 

Formulae in Excel: 

First click on start button at the bottom of the screen on status bar. Click on 
programs and then on Microsoft excel. Then open a new document. Give the main 
heading and subheading by changing the size so that they look in block letters. Enter 
the data. To calculate go to Insert menu in the menu bar and then click on function 
and then ok. Then select the data to which you want to calculate mean. Then you get 
the required answer. In same way, sample means standard deviation lower count 
limit and upper count limit. Go to insert menu and click on function and select the 
required operation to be done and select the data and calculate. Formulas for all the 
above are given below. 

Mean = (s1 + s2 + s3 + s4 + s5)/5; 

Sample mean = avg (mean) 

Standard deviation = (mean, sample, mean) 

Sample standard déviation= avg (Standard déviation) 

Lower count limit = sample mean – sample standard deviation. 

Upper count limit = Sample mean + Sample Standard deviation 

Hyper linking: 

        First click on start button of the screen on status bar. Click on programs 
and then Ms-excel. To get a new blank worksheet go to programs and then click on 
excel sheet. Rename the first sheet as student by right clicking on sheet 1 and 
renaming. Insert hyperlink insert and click on hyperlink. Then go to sheet 2 and 
rename as CSE type in particulars of ECE right click on sheet 3. Then go to sheet -4 
rename as IT. In this type all the four sheets are created. 

WORKSHEET 

                    First click on start button at the bottom of the screen on status bar. Click 
on programs and then Ms-excel. Then enter the data as given. Enter the student’s 
names, Subjective wise marks, total and avg. Then calculate the total and avg by 
using formula. Then go to Data menu and click sort. Under first key sort, click custom 
sort order needed i.e. ascending order or alphabetical order and then click o.k. Then 
the required worksheet is prepared, 
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Week 15: 

TASK 18: 

            Performance Analysis-Features to be covered:-split cells, freeze panes, 
group and outline, sorting, Boolean and logical operators, Conditional 
formatting 

PURPOSE:  

       To create Excel with split cells, freeze panes, group and outline, sorting, Boolean 
and logical operators, conditional formatting  

THEORY: 

Split Cells: 

Excel allows you to split the workbook window into two horizontal or vertical panes 
and also to split cells or data across many cells. 

Sort:  

5. Click a cell in the list you want to sort. 

6. On the Data menu click sort. 

7.  Under first key sort click the custom sort order you want and then click ok. 

Click any other sorting option you want 

Freeze Panes: 

 You can freeze a pane from a split window or just freeze rows or columns 
without splitting the window. 

PROCEDURE: 

Sort: 

 First click on start button at the bottom of the screen on status bar. Click on 
programs and then Ms-excel. Then enter the data as given. Enter the student’s 
names, Subjective wise marks, total and avg. Then calculate the total and avg by 
using formula. Then go to Data menu and click sort. Under first key sort, click custom 
sort order needed i.e. ascending order or alphabetical order and then click o.k. Then 
the required worksheet is prepared 

Split cells: 
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Spread the content of one cell over many cells 

1. Copy the data you want into the upper-leftmost cell within the range.  

2. Select the cells you want to merge.  

3. To merge cells in a row or column and center the cell contents, click Merge 
and Center on the Formatting toolbar.  

Split merged cells 

 

1. Select the merged cell  When cells have been combined, Merge and Center 
on the Formatting toolbar is selected 

2. Click Merge and Center on the Formatting toolbar.  

Divide text across cells  

 

1. Select the range of cells that contains the text values. The range can be any 
number of rows tall, but no more than one columns wide.  

2. On the Data menu, click Text to Columns.  

3. Follow the instructions in the Convert Text to Columns Wizard to specify how 
you want to divide the text into columns.  

Split Windows: 

1. At the top of the vertical scroll bar or at the right end of the horizontal scroll 
bar, point to the split box.  

2. When the pointer changes to a split pointer, drag the split box down or to the 
left to the position you want.  

Freeze Panes: 

1. To freeze a pane, do one of the following:  
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The top horizontal pane    Select the row below where you want the split to 
appear. 

The left vertical pane    Select the column to the right of where you want the 
split to appear. 

Both the upper and left panes    Click the cell below and to the right of 
where you want the split to appear. 

2. On the Window menu, click Freeze Panes.  

Outline: 

 

1. Outline the data automatically 

1. Select the range of cells you want to outline. To outline the entire 
worksheet, click any cell on the worksheet. 

2. On the Data menu, point to Group and Outline, and then click Auto 

Outline. Outline the data manually 

3. Select the rows or columns that contain detail data.  

4. On the Data menu, point to Group and Outline, and then click 
Group. The outline symbols appear beside the group on the screen. 

5. Continue selecting and grouping detail rows or columns until you have 

created all of the levels you want in the outline.  

Group: 

Group objects 

1. Select the objects you want to group.  

To select multiple objects, hold down SHIFT while you select each object. 

2. On the Drawing toolbar, click Draw, and then click Group.  

Ungroup objects 

1. Select the group you want to ungroup.  

2. On the Drawing toolbar, click Draw, and then click Ungroup.  

To continue ungrouping, click Yes when the message box appears. 

To change an individual object, continue to select and ungroup objects until 

the one you want becomes available. 
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3. Use the tools on the Drawing toolbar to change the object 

Conditional Formatting: 

 

1. Select the cells for which you want to add, change, or remove conditional 
formatting  

2. On the Format menu, click Conditional Formatting.  
3. Do one of the following:  

Add a conditional format 
1. Do one of the following:  

To use values in the selected cells as the formatting criteria, click Cell 
Value Is, select the comparison phrase, and then type a constant 
value or a formula. If you enter a formula, start it with an equal sign 
(=). 
To use a formula as the formatting criteria (to evaluate data or a 
condition other than the values in selected cells), click Formula Is and 
then enter the formula that evaluates to a logical value of TRUE or 
FALSE. 

2. Click Format.  
3. Select the formatting you want to apply when the cell value meets the 

condition or the formula returns the value TRUE.  
4. To add another condition, click Add, and then repeat steps 1 through 

3.  
You can specify up to three conditions. If none of the specified 
conditions are true, the cells keep their existing formats 

Change or remove a conditional format   

 
Do one or more of the following:  

o To change formats, click Format for the condition you want to change.  
o To reselect formats on the current tab of the Format Cells dialog box, 

click clear and select new formats.  

o To remove one or more conditions, click Delete, and then select the 
check box for the conditions you want to delete 
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TASK 19: 

Cricket Score card-Features to be covered:-pivot tables, Interactive Buttons, 
Importing data, Data Protection, Data validation 

PURPOSE: To learn about pivot tables, Interactive Buttons, Importing data, Data 
Protection, Data validation. 

THEORY: 

Pivot Tables: 

A PivotTable report is an interactive table that quickly combines and compares large 
amounts of data. You can rotate its rows and columns to see different summaries of 
the source data, and you can display the details for areas of interest. 

Interactive Buttons: 

MS- Excel allows you to create Interactive Buttons 

Data Protection: 

Ms excel allows you to protect your work sheet from being added or renamed or 
deleted or copied   by providing password protection to your worksheets. 

Data Validation: 

Data validation is a tool that helps you to control the kind of information that is 
entered in your worksheet. With data validation you can: 

 Provide users with a list of choices 

 Restrict entries to a specific type or size 

 Create custom settings 

PROCEDURE: 

Pivot Tables: 

1. Open the workbook where you want to create the PivotTable report.  

o If you are basing the report on a Web query, parameter query, report 
template, Office Data Connection file, or query file, retrieve the data 
into the workbook, and then click a cell in the Microsoft Excel list 
containing the retrieved data. 

If the retrieved data is from an OLAP database, or the Office Data 
Connection returns the data as a blank PivotTable report, continue 
with step 6 below. 

o If you are basing the report on an Excel list or database, click a cell in 
the list or database. 

2. On the Data menu, click PivotTable and PivotChart Report.  
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3. In step 1 of the PivotTable and PivotChart Wizard, follow the instructions, and 
click PivotTable under What kind of report do you want to create?  

4. Follow the instructions in step 2 of the wizard.  

5. Follow the instructions in step 3 of the wizard, and then decide whether to lay 
out the report onscreen or in the wizard.  

Button: 

 Select the commands tab 

 Scroll to the bottom of the categories list 

 Select the custom button 

 Drag this button to your new toolbar in the location where you want it 
to be. 

 You can obtain a description of the command button by selecting the 
command and pressing the Description  button 

Data Protection: 

Protect worksheet elements from all users 

1. Switch to the worksheet you want to protect. 

2. Unlock any cells you want users to be able to change: select each cell or 
range, click Cells on the Format menu, click the Protection tab, and then 
clear the Locked check box. 

3. Hide any formulas that you don't want to be visible: select the cells with the 
formulas, click Cells on the Format menu, click the Protection tab, and then 
select the Hidden check box. 

4. Unlock any graphic objects you want users to be able to change. 

You don't need to unlock buttons or controls for users to be able to click and use 
them. You can unlock embedded charts, text boxes, and other objects created with 
the drawing tools that you want users to be able to modify. To see which elements on 
a worksheet are graphic objects, click Go To on the Edit menu, click Special, and 
then click Objects. 

1. Hold down CTRL and click each object that you want to unlock.  

2. On the Format menu, click the command for the object you selected: 
AutoShape, Object, Text Box, Picture, Control, or WordArt.  

3. Click the Protection tab.  

4. Clear the Locked check box, and if present, clear the Lock text check 
box.  

5. On the Tools menu, point to Protection, and then click Protect Sheet. 
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6. Type a password for the sheet. 

7. In the Allow all users of this worksheet to list, select the elements that you 
want users to be able to change. 

8. Click OK, and if prompted retype the password. 

Protect a shared workbook 

1. If the workbook is already shared, and you want to assign a password to 
protect the sharing, unshare the workbook. 

1. Have all other users save and close the shared workbook. If other 
users are editing, they will lose any unsaved work.  

2. Unsharing the workbook deletes the change history. If you want to 
keep a copy of this information, print out the History worksheet or copy 
it to another workbook.  

1. On the Tools menu, point to Track Changes, and then click 
Highlight Changes.  

2. In the When box, click All.  

3. Clear the Who and Where check boxes.  

4. Select the List changes on a new sheet check box, and then 
click OK.  

5. Do one or more of the following:  

 To print the History worksheet, click Print .  

 To copy the history to another workbook, select the 
cells you want to copy, click Copy, switch to another 
workbook, click where you want the copy to go, and 

click Paste .  

3. On the Tools menu, click Share Workbook, and then click the 
Editing tab.  

4. Make sure that you are the only person listed in the Who has this 
workbook open now box.  

5. Clear the Allow changes by more than one user at the same time 
check box.  

If this check box is not available, you must unprotect the workbook 
before clearing the check box. 

1. Click OK, point to Protection on the Tools menu, and then 
click Unprotect Shared Workbook.  

2. Enter the password if prompted, and then click OK.  
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3. On the Tools menu, click Share Workbook, and then click the 
Editing tab.  

6. When prompted about the effects on other users, click Yes.  

2. Set other types of protection if you want: Give specific users access to 
ranges, protect worksheets, protect workbook elements, and set passwords 
for viewing and editing. 

3. On the Tools menu, point to Protection, and then click Protect Shared 
Workbook or Protect and Share Workbook. 

4. Select the Sharing with track changes check box. 

5. If you want to require other users to supply a password to turn off the change 
history or remove the workbook from shared use, type the password in the 
Password box, and then retype the password when prompted. 

6. If prompted, save the workbook 

Protect a workbook file from viewing or editing 
1. On the File menu, click Save As. 

2. On the Tools menu, click General Options. 

3. Do either or both of the following: 

o If you want users to enter a password before they can view the 
workbook, type a password in the Password to open box, and then 
click OK. 

o If you want users to enter a password before they can save changes 
to the workbook, type a password in the Password to modify box, 
and then click OK. 

4. When prompted, retype your passwords to confirm them. 

5. Click Save. 

6. If prompted, click Yes to replace the existing workbook. 

Data Validation: 

 Select the cells in which you want to apply data validation 

 From the Data menu, choose Validation 

 From the Allow drop-down list choose List 

 In the source box type an equal to sign and list the name  
 Click ok 

 
Viva questions: 

1) Explain about pivot table reports 
2) Define macro 
3) Define template 
4) How can you open protection tool in excel? 
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Week:16 

TASK 20: 

PPT Orientation, Slide Layouts, Inserting Text, Word Art, Formatting Text, 
Bullets and Numbering, Auto Shapes, Lines and Arrows in both LaTeX and 
PowerPoint. 

TITLE:  

 Create a power point presentation consists of slide layouts inserting 
text, formatting text, bullets and numbering of five slides with following 
information’s. 

Slide 1 – contents Slide 2 – Name  Slide 3 – Address  Slide 4 – Hobbies 

Slide 5 – Friends 

PURPOSE: 

 To maintain a PowerPoint presentation with some specifications 

THEORY: 

SLIDE LAYOUT:  

 

1. On the format menu, click slide layout. 

2. On the slides tab in normal view, select the slides; you want to apply a 
layout too. 

3. In the slide layout task pane, point to layout you and then click it. 

4. A new slide can also be inserted within the task pane. Point the layout you 
want the slide to have, click the arrow and then click the insert new slide. 

INSERT TEXT: 
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1. Text can be added to layout. 

2. Align text in the top, middle or bottom of a cell. 

3. Align text on the right or left, or in the center of a cell. 

4. Change cell margins. 

5. Insert a tab in a table. 

6. To make the symbol command available, in normal view, place the 

insertion point on the outbox tab or in a text place holders on the slide. 

7. On the insert menu, click symbol. 

8. To change fonts, click a name in the font box. 

FORMATTING TEXT: 

 

1. Select the text you want to format as superscript or subscript. 

2. On the format menu, click font. 

3. To show or hide text formatting, on the standard toolbar, click show 
formatting. 

BULLETS AND NUMBERINGS: 
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1. Select the lines of text that you want to add bullets or numbering to. 

2. Click bullets or numbering. 

AUTOSHAPES:

 

1. Select the auto shape that has the text you want to position. 

2. Double-click the selection rectangle of the auto shape or text box and then 
click the text box tab in the format dialog box. 

3. In the text anchor point box, click the position you want the text to start in. 

        LINES AND ARROWS:  

 

1. In Microsoft power point, double click the chart. 

2. Double click the chart item you want to change. 

3. On the patterns tab, do one or both of the following. 

4. To change the colors, patterns or lines, select the options you want. 

5. To specify a fill effect, click fill effect and then select the options you want 
on the gradient, text patterns or picture tabs. 

To return to the slide, click outside the about. 

PROCEDURE: 

 First click on start button at the button of the screen on status bar. Click on 
programs and then Microsoft PowerPoint. Go to file and new. Then you find different 
pattern of slides on right side of your screen. Then select which is completely empty. 
Then enter the contents in the first slide as per given information, name in the second 
slide, Address in the third slide, Hobbies in the fourth slide and friends in the fifth 
slide. Except first slide, all the second, third, fourth, fifth slides should be inserted. 
When you select pattern of slide from a new slide, on slide which you selected you 
will find an arrow towards its right side, click that arrow and then again click insert 
slide. Then save it. Then adjust the layout. Then format the text then give bullets or 
numbering to the text if required. Go to auto shapes. Select more auto shapes and 
insert wherever required. Then again go to insert option and select new slides. And 
select chart and a chart with datasheet appear. Give the name, roll no, marks in three 
subjects and calculate the total. Then save the file 
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TASK 21: 

Hyperlinks, Inserting –Images, Clip Art, Audio, Video, Objects, Tables and 
Charts 

TITLE: Create a power point presentation consisting of hyperlinks, inserting 
images, clip art, audio, video objects of 4 slides with the following information. 

Slide 1:- Name of your college in bold letters.Slide 2:- Address of your college 
in bold letters.Slide 3:- List of all available courses.Slide 4:- Extra co-curricular 
activities.And apply the transaction effects and set the time three seconds for 
each slide and view it in slide show. 

PURPOSE: To maintain a PowerPoint presentation using some specifications 

THEORY: HYPERLINK:  

1. Select the text or object that you want to represent the hyperlink. 

2. Click insert hyperlink. 

3. Under link to, click place in this document. 

INSERT IMAGES: 

 

1. Click where you want to insert the picture. 

2. On the drawing tool bar, click insert picture. 

3. Locate the folder that contains the picture that you want to insert, and then 
click the picture file. 

CLIP ART:  



DEPARTMENT OF CSE IT WORKSHOP LAB MANUAL  

 

98 

 

 

1. On the insert menu, point to structure and then click clipart. 

2. in the clipart task pane, in the search for box, type a word or phrase that 
describes the clip, you want to type in all or same of the file menus of the 
clip. 

3. in the results box, click the clip to insert it. 

AUDIO VIDEO OBJECTS: 

 

1. On the slide show menu, click setup show. Under performance check box. 
If your computer has their capability, office PowerPoint will attempt to use 
it. 

2. Animation performance will be much better with a video card that has 
Microsoft direct 3D. 

TABLE: 
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1. On the standard tool bar, click insert table. 

2. Print to select the numbers of rows and columns you want and then click. 

      CHART: 

 

1. Click the slide where you want to place the embedded object. 

2. On the insert menu, click chart. 

3. Click a cell on the data sheet and then type the information you want. 

To return to the slide, click outside the chart 

 

PROCEDURE: 

 First click on start button at the bottom of the screen on status bar. Click on 
programs and then Microsoft power point go to file menu. Then you find different 
pattern of slides on right side of your screen. Then select which is completely empty. 
Then enter the name of your college in bold letters. Address of your college in bold 
letters in the second slide. List of all the available courses in the third slide, extra co-
curricular activities in the fourth slide except first slide, all the second, third, fourth 
slide should be inserted. When you select pattern of slide from a new slide, on slide 
which you selected, you will find an arrow towards it right side click that arrow and 
then again click insert slide. Then save it the select the slide show and then select 
the view show option. Then review the presentation in slide show by selecting next 
and after completing the slide show then click end show. Click on start button at the 
button of the screen on status bar, click on programs and then Microsoft power point. 
Go to file menu. On insert menu and select table option and give no. of rows and no. 
of columns and give the name, Roll no and marks in three subjects and find the total 

 Viva Questions: 

1) Define hyper link 

2) Define slide show 

3) Define slide transition 

4) What is animation 

5) How can you insert a table in power point? 
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TASK 22: 

Master Layouts (slide, template, and notes), Types of views (basic, 
presentation, slide slotted, notes etc), Inserting – Background, textures, Design 
Templates, Hidden slides. 

TITLE: 

 Create a power Point presentation on business by using master layouts 
and see the presentation in different views. 

PURPOSE: 

 To maintain a power point presentation with some specifications 

THEORY:- 

       MASTER LAYOUTS:-  

 

1. On the view menu, point to master, and then click slide master. 

2. To insert a slide master, do the presentation given in slides and lastly 
add date and footer to the slides. 

 

      SLIDE SHOW: 

1. On the slides tab in the normal view, select the slides you want to set the 
things for. 

2. On the slide show menu, click side transition. 
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3. Under advance slide, select the automatically after checkbox, and then 
number of seconds you want the slide to appear on the screen. 

 

PROCEDURE: 

 First click on start button. Then click programs, and then power point 
presentation. Then select file menu and click on new. Then you get a new blank 
presentation. Then in the first slide, enter the title as business and give product name 
as sub title. Then insert the second slide. Then enter the title as about the product 
and give description as sub title. Then insert the third slide and enter the title as sales 
about product and enter something about it sales. In this way, complete the three 
slides. Then click on view and then master and then enter date in the space provided 
for footer. Then you find these two in all slides and then again go to view and click on 
slide show. 

Viva Questions: 

1) What do you mean by clip art? 

2) What is grouping of objects? 

3) What is ungrouping of objects? 

4) What are the contents of Microsoft clip gallery? 

5) Explain about custom animation 
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TASK 23:: 

Using Auto content wizard, Slide Transition, Custom Animation, Auto 
Rehearsing 

TITLE:  

 Created a power point presentation to welcome a guest using auto 
content wizard, slide transaction, custom animations and auto-recharging 
effects. 

PURPOSE: 

 To maintain a power point presentation with some specifications 

THEORY: 

      AUTO-CONTENT WIZARD:  

 

 

1. If the new presentation task pane is not displayed on the file menu, click 
new. 

2. Under new, click from auto content wizard, and then follow the instructions 
in the wizard. 

3. In the presentation, replace the text suggestions with the text you want 
and then make any other changes you want such as adding or deleting 
slides, adding art elements or animation effects and inserting headers and 
footers. 

4. When you finish, on the file menu, click save, type a name in the file name 
box, and then click save. 

      SLIDE TRANSACTION: 
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It helps to design the slides in anyway with our own interest we can set any 
thing we want. 

 

    

 

 

 

 

 

 

 

 

 

 

 

 

 CUSTOM ANIMATION: It’s used to add animation to the element of the slide. 

      

AUTO RECHARGING: 

1. Select the auto shape or text box you want to resize. 

2. Double click the selection rectangle of the auto shape or text box, and 
then click the text box tab in the format dialog box. 

3. Select the resize. Auto shape to fit text check box. 

PROCEDURE: 

 First click on start button at the button of the screen on status bar, click on 
programs and then Microsoft power point. Go to file menu. Prepare some slides in 
which each given the information about when you are going to welcome and topics to 
be covered. Now go to ‘Auto content wizard” in that you are provided with four 
options. Click text in that dialog box to get them and give the details. Then go to slide 
transaction. In that we can set the time, font design by selecting apply to all slides. 
Go to customer animation option in ‘slide show’ and there select or required type of 
presentation. 
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TASK 24: 

Help students in preparing their personal website using Microsoft/ equivalent 
(FOSS) tool publisher. Topic covered during this week includes - Publisher 
Orientation, Using Templates, Layouts, Inserting text objects, Editing text 
objects, Inserting Tables, Working with menu objects, Inserting pages, Hyper 
linking, Renaming, deleting, modifying pages, Hosting website. 

PURPOSE: 

To learn Using Templates, Layouts, Inserting text objects, Editing text objects, 
Inserting Tables, Working with menu objects, Inserting pages, Hyper linking, 
Renaming, deleting, modifying pages, and Hosting website 

THEORY: 

Layouts: 

Layout guides comprise margin, column, row, and baseline guides. They are used to 
create a grid on a master page. This grid appears on every page in your publication 
where that master page is used. Use layout guides to organize text, pictures, and 
other objects into columns and rows so that your publication will have an ordered, 
consistent look. Set layout guides in the Layout Guides dialog box (Arrange menu). 

Margin guides, column guides, and row guides are represented by blue dotted lines; 
baseline guides are represented by gold dotted guides; and ruler guides are 
represented by green dotted lines 

Hyper Link: 

hyperlink is a link from a document that, when clicked, opens another page or file. 
The destination is frequently another Web page, but it can also be a picture, an e-
mail address, or a program. The hyperlink itself can be text or a picture. 

PROCEDURE: 

Template: 

1. Create the publication you want to use as a template. 

2. On the File menu, click Save As.  

3. In the File name box, type a name for the template.  

4. In the Save as type box, click Publisher Template.  

The destination folder changes to Templates. You need to save your 
template in this folder if you want it to appear in the Preview Gallery of the 
New Publication task pane later. 

5. Click Save. 

Layouts: 

 On the View menu, click Boundaries and Guides.  
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Note If the Snap to Guides command is on (On the Arrange menu, point to Snap, 
and then click To Guides), objects will continue to snap to the guides even when the 
guides are hidden 

InsertingTextObjects: 
In your publication, select an AutoShape 

1. Type the text you want 

Editing Text objects: 

1. Double-click the WordArt object you want to change.  

2. In the Edit WordArt Text dialog box, change the text, and then click OK. 

Inserting Tables: 

1. On the Objects toolbar, click the Insert Table.  

2. Click inside your publication.  

The Create Table dialog box will appear. 

3. Select the options you want, and then click OK.  

4. Size your table.  

Select the table, position the mouse pointer over a selection handle until you 
see the Resizer icon, and then drag to resize the table. 

5. In the table, click the cell where you want to add text, and then start typing.  

To add text to another cell, click inside that cell. 

Each cell expands to fit your text, unless you lock the table size by clearing 
the check mark next to Grow to Fit Text on the Table menu. 

Hyperlink: 
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Create a hyperlink to a file or page 

1. Select either text or a picture.  

2. Click Insert Hyperlink.  

3. Under Link to, click Existing File or Web Page.  

4. Do one of the following:  

o To select a file from your My Documents folder, click Current Folder.  

o To select a file that was recently viewed in your Web browser, click 
Browsed Pages.  

o To select a file that you were recently working in, click Recent Files.  

5. Navigate to the file or page you want.  

Create a hyperlink to an e-mail address 

1. Select either text or a picture.  

2. Click Insert Hyperlink.  

3. Under Link to, click E-mail Address.  

4. Either type the e-mail address you want in the E-mail address box, or select 
an e-mail address from the recently used e-mail addresses box.  

5. In the Subject box, type the subject of the e-mail message. 

Create a hyperlink to another place in your document 

1. Select either text or a picture.  

2. Click Insert Hyperlink.  

3. Under Link to, click Place in This Document.  

4. Select the page you want 

Create a hyperlink to a new page 

1. Select either text or a picture.  

2. Click Insert Hyperlink.  

3. Under Link to, click Create New Document.  

4. Either type the path and name of the new file, or click Change to navigate to 
a location.  

5. Select either Edit the new document later or Edit the new document now.  

Pages: 
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Create a master page 

1. On the View menu, click Master Page.  

2. In the Edit Master Pages task pane, click New Master Page.  

3. In the New Master Page dialog box, do any of the following:  

o In the Page ID (1 character) box, type a single-character identifier for 
your new master page. This can be any single Unicode character.  

o In the Description box, type a brief description of your new master 
page.  

o If you want your new master page to be a two-page spread, select 
Two-page master.  

4. Click OK.  

Edit a master page 

1. On the View menu, click Master Page.  

2. In the Edit Master Pages task pane, click the arrow next to the master page 
you want to edit, and then click Edit.  

3. Edit the page as desired.  

4. To see the updated publication pages, click View publication pages, and 
then navigate to a page to which the master page is applied 

Delete a master page 

1. On the View menu, click Master Page.  

2. In the Edit Master Pages task pane, click the arrow next to the master page 
you want to delete, and then click Delete.  

3. In the alert box, click Yes 
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TEXT BOOKS & REFERENCE BOOKS: 

TEXT BOOK  

 

1. Comdex Information Technology Course tool kit   ‘Vikas Gupta, WILEY    
Dreamtech 

 

 2. Introduction to Computers- Peter Norton’s. 

 

REFERENCE BOOKS 

 

1. Complete computer upgrade and Rep-air book, 3rd edition Cheryl A 
Schmidt, Wiley Dreamtech 

 

2. Introduction to Information Technology, ITL Education Solutions limited, 
Pearson Education. 

 

3. PC Hardware and A +Handbook –Kate J. Chase PHI (Microsoft) 

 

4. Latex Companion –Leslie Lamport, PHI/Pearson 

 

5. “Introduction to Computers with MS-Office 2000”, Alexis Leon and 
Mathews Leon, Leon Tech world. 
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